Oracle CX Service

Using B2B Service

21D
5 Chat

Overview of Chat
Set Your Availability for Chat
Chat Notifications
Chat with Customers
Switch Among Different Chat Conversations
Transfer a Chat to a Queue
Wrap Up a Chat
View Chat Wrap Up and Transcript
Delete Chat Transcripts to Comply with General Data Protection Regulation (GDPR)

6 Computer Telephony Integration (CTI)

Handle Incoming Calls
Overview of Contact Search in CTI
Search for a Contact in CTI
Overview of Wrapping Up an Interaction
Wrap Up an Interaction

7 Cobrowse

Enable and Use Cobrowse
Oracle Cobrowse
Differences Between Cobrowsing and Screen Sharing

8 Notifications

Omnichannel Notifications
Bell Notifications for Service Requests
Personalize Your Notifications
Push Notifications for Mobile

9 Work Orders

Generic Work Orders
Oracle Field Service Work Orders
FAQs about Work Orders
How to View Audit History for a Work Order
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Service Analytics</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>View Service Analytics</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>Create Service Analytics</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>Overview of Service Infolets</td>
<td>89</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons.

If you don’t see Show Help Icons in the Settings and Actions menu, you can access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- Community: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- Training: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Diversity and Inclusion

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a diverse workforce that increases thought leadership and innovation. As part of our initiative to build a more inclusive culture that positively impacts our employees, customers, and partners, we're working to remove insensitive terms from our products and documentation. We're also mindful of the necessity to maintain compatibility with our customers' existing technologies and the need to ensure continuity of service as Oracle's offerings and industry standards evolve. Because of these technical constraints, our effort to remove insensitive terms is ongoing and will take time and external cooperation.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Oracle Accessibility Learning and Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 About This Guide

Audience and Scope

This guide is intended for users who are involved in creating and managing service requests. The activities in this guide are only available if the implementation tasks for B2B Service are complete.

Related Guides

To understand more about the information covered in this guide, you can refer to the list of guides in the following table.

<table>
<thead>
<tr>
<th>Guide</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle CX Service Using Knowledge Management</td>
<td>Describes how administrators, agents, authors, and other knowledge base contributors can implement and use Knowledge in Oracle B2B Service.</td>
</tr>
<tr>
<td>Oracle Applications Cloud Using Common Features</td>
<td>Provides an overview of the application functionality common across the applications</td>
</tr>
<tr>
<td>Oracle CX Sales Creating and Administering Analytics</td>
<td>Contains information about supplied reports and analytics, as well as how to create your own reports.</td>
</tr>
<tr>
<td>Oracle CX Sales Using Customer Contracts</td>
<td>Contains information to help end users who are charged with creating and managing customer contracts.</td>
</tr>
<tr>
<td>Oracle CX Sales Using Sales</td>
<td>Contains information to help sales managers, sales people, and other sales end users when using Oracle CX Sales to perform their day-to-day tasks.</td>
</tr>
</tbody>
</table>

Related Topics

- Oracle Help Center

---

[Oracle CX Service Using B2B Service]

Chapter 1

About This Guide
2 Service Requests

Work With Service Requests

Create, Edit, and Resolve

Create and Edit a Service Request

Watch video

You can edit or create a service request (SR) either from the Navigator, or from the Edit Account (or Edit Contact) page.

- From the Navigator:
  a. Select the Service Requests menu from the Navigator.
  b. In the Service Requests list page, click an existing SR to edit, or click Create Service Request to create a new SR.

- From the Edit Account or Edit Contact page:
  a. Click the Service Request menu option. The Service Requests page opens with a list of SRs that are associated with the account or contact.
  b. Click a service request to edit, or click Create Service Request to create a new SR.

Note:
- If you open a new service request page from an existing account or contact, the fields are automatically populated in the Create Service Request page.
- To create service requests for partner accounts, see the topic "Creating and Editing Service Requests for Partners".
- To change a Create or Edit Service Request page from a modal window to a dynamic tab, click Actions and then select Switch to Service Request Workspace. To know more about how to configure and use Workspace, refer the Oracle CX Sales Guides.
- Your administrator can make SRs read-only for specific users. For more information, see the topics "Set Up Read-Only Access to the Service Request Header" and "Set Up Read-Only Access to the Service Request Header and Service Request Messages" in the Implementing B2B Service guide.

Related Topics
- Create a Work Order
- About Click to Edit
Overview of a Service Request Lifecycle

Creating or editing an SR includes the following steps. You don’t need to do all the steps, and they don’t need to be done in the order we are presenting.

- Enter the summary information: View SR details about what the service request is about such as the customer account, primary contacts, SR description, and so on. You can also add tags to the SR. For more information about adding tags, see “Tagging Service Requests”.

- View Interaction History: View details about the various interactions an agent has had for a service request. Get details on who called whom, through what communication channel, what were his top interactions, and with what customer. The view always shows the parent interaction with the associated child interactions (including the cross-channel interactions) in a nested view under the parent interaction. To view the associated interactions, click the + icon next to the parent interaction.

- Compose messages: Use the Messages tab to view, create, and send messages and notes on the SR.

- Add contacts: Add customer contacts to the SR.

- Add team members: Add team members who can view and work on the SR.

- Create activities: Create activities such as appointments, tasks, and log calls with the customer.

- View linked articles: View related knowledge articles that can help resolve the SR.

- View Service Request Milestones: View the service milestones for the SR.

- Manage Work Orders: Manage your work orders to facilitate resolution of the SRs.

- View Audit History: View changes to the application data such as the business objects that were created, updated, and deleted.
A Typical SR Flow
This flowchart describes the process flow of a Service Request:

An Example of an SR Process
A typical and simple example of an SR Lifecycle flow is given below:

- The agent receives an inbound email from a customer. This creates the SR in "New" status.

Use any of the following methods to create an SR:

- Customer sends email to create the SR. This requires setup by an administrator.
- Agent manually creates the SR by clicking the **Create SR** button.
- Use other methods such as REST or Import.

- The agent starts working on the SR, and changes the status of the SR to "In Progress".

Use any of the following methods to update the SR:

- Customer sends email to update the SR.
- Customer updates the SR using Digital Customer Service.
- Agent manually updates the SR.
- Use other methods such as REST or Import.
• The agent realizes that they need some additional information from the customer. So they send an email to the customer and flip the SR status to “Waiting”.
• The customer replies back to the email. At this time the application changes the status back to IN PROGRESS. Here status change isn't ready-to-use, and requires setup in the application.
• The agent replies back to the customer with the solution and sets the SR status to Resolved. Use any of the following methods to resolve the SR:
  o Automatic Resolve of the SR from Waiting status. Require setup by an administrator.
  o Customer resolves the SR using Digital Customer Service.
  o Agent manually updates the SR.
  o Use other methods such as REST or Import.
• After X days of the SR being resolved, the application flips the status of the SR to Closed, if the customer has configured the ESS job to close SRs.

Related Topics
• About Click to Edit
• Enable and Use Cobrowse

Enter Service Request Summary Details
After you have created an SR, open the Service Requests Summary page if you must enter more information about the SR. For information about creating an SR and accessing the Service Requests Summary page, see the Creating and Editing a Service Request topic.

When an SR is created from an email received from a customer, fields such as title, primary contact, account, and channel are set on the SR. For more information about how the various fields are set on the SR, see the Oracle CX Service Implementing B2B Service guide.

Note: If the status of an SR is Closed, you can't do the following: edit any field in the SR, add a message, or reopen the SR.

<table>
<thead>
<tr>
<th>Field</th>
<th>What you enter in the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Select the account associated with the service request.</td>
</tr>
<tr>
<td></td>
<td>Note: If the account associated with the SR is merged with another account later, then the account remaining after the merge is associated with the SR.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>Select the primary contact for the account. The account and the primary contact must be related to one another.</td>
</tr>
<tr>
<td></td>
<td>Depending on your selection, the following happens:</td>
</tr>
<tr>
<td></td>
<td>• If you select an account, then the contacts of only that account is listed for search.</td>
</tr>
<tr>
<td></td>
<td>• If you don't select an account, then all contacts are available for search.</td>
</tr>
<tr>
<td></td>
<td>• If you attempt to change an account after selecting a primary contact, a message displays confirming the deletion of the invalid contacts associated with the service request. If you select Yes, the invalid contacts associated with the account are deleted.</td>
</tr>
<tr>
<td>Field</td>
<td>What you enter in the field</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If two contacts are merged, you may see a change in the primary contact of an SR. The contact remaining after the merge is now associated with the SR, as it replaces the merged contact.</td>
</tr>
<tr>
<td>Severity</td>
<td>Select the SR severity.</td>
</tr>
<tr>
<td>Critical</td>
<td>Select this option to include the service request in critical SR reporting metrics. It doesn't affect the service request resolution.</td>
</tr>
<tr>
<td>Category</td>
<td>Select an SR category either from the drop-down list, or use the type-ahead feature to start typing and quickly find the category you want. As you type, the SR categories that match are highlighted hierarchically. <strong>Note:</strong> To enable this feature, set the profile option, <code>SVC_TYPEAHEAD_CATEGORY_LOV_ENABLED</code> to Yes. You can also click the folders icon, and select the category from the dialog box. Expand or collapse category groups to navigate through the hierarchies. You can select a category at any level in the hierarchy for Service Requests. Click OK once you have selected the category you want.</td>
</tr>
<tr>
<td>Product</td>
<td>Select the product group or product that's associated with the SR.</td>
</tr>
<tr>
<td>Queue</td>
<td>Select a queue to which the SR is assigned.</td>
</tr>
</tbody>
</table>
| Assigned To | Select the resource owner of the service request who appears as the primary member in the SR team. This field is available only to users with the following duty roles:  
- Service Request Troubleshooter  
- Service Request Power User  
- Service Request Channel User  
The field isn't available to users with the Contributor role, such as sales representative. |
| Channel Type | Select a channel the SR was original sent through. You can select Email, Phone, or Web channel. |
| Status | Select the status of the SR. |
| Attachment | Add an attachment to the SR by selecting a file type, browsing, and uploading an attachment. If the Category field is available, select Miscellaneous category for attachments that you want to share with the customer. Select Internal category for attachments that you want to share only within the team. |
### Field | What you enter in the field
--- | ---
| **Note:** Don't select the Inline Attachments category when you add an attachment to a service request or to an SR message. |
| **Tag** | Add an existing tag or a new tag to the SR. You can associate multiple tags to an SR. This gives you flexibility to search for or organize SRs based on your requirement, without modifying the main category hierarchy.  
For more information about tags, see “Tags for Service Requests”. |
| **Problem Description** | Describes the nature of the SR. You can use SmartText entries.  
You can move the Problem Description field within a field group in the Page Layout of the Service Request details page. You use this page to modify the layout by moving the placement of the Problem Description up or down within the page layout. To know more about how to configure the field within a field group, read the Dynamic Page Layouts section in the Extending Sales and Service Guide. |
| **Solution Description** | Available throughout the lifecycle of the SR. You can prepare notes and draft descriptions, and validate them before formally resolving the SR. You can use SmartText entries. |
| **Asset** | If you have an Asset field enabled on the Summary details, you can associate the required asset from the drop-down list. Assets are specific instances of products that your customers have purchased. They typically have a serial number, date of purchase, date of installation, and so on.  
If you select an account for the SR, then you can select an asset for that account, using the Asset drop-down list. If you don’t select an account but associate a contact with the SR, then you can pick an asset for the contact. If you don’t select an account or a contact, you can’t select an asset. |

**Related Topics**
- Overview of Dynamic Page Layouts
- SR Management Profile Options

**Use a Keyboard to enter Service Request Summary Details**

If you’re using only your keyboard to enter the SR details on the Summary page, to select the value in the **Category** and **Product** fields, do the following:

1. Press the Tab key until you get to the **Product** or **Category** field.
2. Press ALT+Down arrow key to open the list options.
3. Press SHIFT+Tab key to select the Search link and press ENTER.
4. On the **Select Product** window or the **Select Category** window, press Tab to get to the hierarchy that has the product you want to select.
5. After you select the product or category, press SHIFT+Tab to move out of the table.
6. Press the Down arrow key to highlight the record that you want to select.
7. Press SHIFT+ALT+K to select **OK**.  
The product or category is added to the field.
Resolve a Service Request

Use the Resolve Service Request dialog box to enter simple and consistent resolution information of the SR such as outcome, resolution code, and solution description in one place. All the information that you have already entered in the SR gets automatically populated in this dialog box when you open it.

**Note:** To use this feature, the profile option, SVC_ENABLE_RESOLVE_SR must be set to Yes.

1. In the Edit Service Request page, click Actions and select Resolve.
   This displays the Resolve Service Request dialog box for you to enter a solution in preparation for resolving the Service Request.
2. Select the Outcome from the drop-down list that best describes the outcome of the service request.
3. Select a Resolution Code from the drop-down list that contains detailed reporting codes describing how the chosen Outcome was achieved. The options available in this list are dependent on the value you selected in the Outcome list.
4. Enter the details explaining about the solution of the problem up to a maximum of 1000 characters in the Solution Description field. You can use a SmartText entry here.
5. Click Resolve.

Once you have captured the information in the Resolve Service Request dialog box, the information appears in a new Solution section in the Summary page. The Solution Description field is available throughout the lifecycle of the SR, so you can prepare notes and draft descriptions to validate them before the Service Request is formally resolved. You can also use this section to display additional fields, such as Resolved By (the name of the agent who resolved the SR), and Resolution Date (date and time of the SR resolution).

**Related Topics**
- Enable and Use Cobrowse

Closed Service Requests

Service requests (SRs) can be closed only by an internal process. You can’t manually set the status of an SR to Closed. After an SR is closed, you can’t edit the SR, add a message, or reopen it.

Provide Additional Information About SR Attachments and SR Message Attachments

When you’re uploading or editing SR attachments and SR message attachments on the SR, you may sometimes want to provide additional information about them. You can provide this additional information by updating the flexfields on the SR attachments and SR message attachments.

1. Navigate to the specific SR.
2. Upload an attachment with the appropriate attachment category.
   You can upload attachments to the SR or to the SR Message.
3. Click Details for an attachment that you uploaded.
   **Note:** You may have to expand the Attachments dialog to see the attachment flexfields.
5. Update the flexfields as required.
6. Click Update on the Attachment Details Pane to save the flexfields.
7. Click OK to close the Attachments dialog and then save the SR.

**Note:** Sometimes, the Attachment Details pane doesn’t display the contextual segment flexfields that are associated with an attachment category. If this happens, change the category of the attachment and then change it back to the original category. The contextual segment flexfield is now displayed.
Navigate

Service Request Management Options

The Service Requests screen is where you go to manage your service requests. First, to find a specific SR enter its reference number in the **Find** field. To create an SR, see the Creating and Editing a Service request topic. Use the **List** menu to do more. Let’s look at some examples.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View all open SRs</td>
<td>Select <strong>All Open Service Requests</strong>.</td>
</tr>
<tr>
<td>List all SRs assigned to you, which aren’t yet Closed. (This is the default view)</td>
<td>Select <strong>My Open Service Requests</strong>.</td>
</tr>
<tr>
<td>View open SRs that you created</td>
<td>Select <strong>Open Service Requests Created By Me</strong>.</td>
</tr>
<tr>
<td>View SRs assigned to a queue that includes you as a member</td>
<td>Select <strong>Open Service Requests Not Assigned to a Queue</strong>.</td>
</tr>
<tr>
<td>Viewing SRs assigned to a team that includes you as a member</td>
<td>Select <strong>Open Service Requests Where I Am on the Team</strong>.</td>
</tr>
<tr>
<td>Show only the details that you want to see</td>
<td>Select <strong>Columns</strong> from the <strong>View</strong> drop-down list and select the columns you want. To add more columns, select <strong>Manage Columns</strong> in the <strong>Columns</strong> list.</td>
</tr>
<tr>
<td>Refresh the Service Request list page with the latest updates</td>
<td>Click the <strong>Refresh icon</strong> to easily check for updates without the need to modify or toggle the current saved search.</td>
</tr>
<tr>
<td>Create your own SR lists</td>
<td>Select <strong>Create or Edit Lists</strong> in the <strong>List</strong> drop-down list. Use the Advanced Search form to add, edit, or remove criteria.</td>
</tr>
<tr>
<td>Create your own searches</td>
<td>Select <strong>Create or Edit Lists</strong>.</td>
</tr>
<tr>
<td>Do an advanced search</td>
<td>Click the <strong>Show Advanced Search</strong> button. For more information, see the Perform an Advanced Search topic.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Define Fields
- Expose Additional Fields for Service Request Mass Update

Overview of Click to Edit

Use **Click to Edit** in the Service Request list page to do tasks such as in-line edit of records, and updates of records. This profile option isn’t enabled by default. Your administrator must set the profile option to enable the feature.
You can use the Service Request list page to do the following:

- Perform in-line editing of records directly from landing list pages.
- Update records without drilling down to each record.
- Maintain an overview of the list pages.
- Simplify data entry and improve productivity.

**Related Topics**
- Enable and Use Cobrowse

**How You Use the Dynamic Tabs and Nested Dynamic Tabs**

Top-level **Dynamic Tabs** in the Service Request work area help save you time. Simultaneously interact with multiple records, access related information about service interactions and display information about SRs, queues, contacts and accounts. The maximum number of dynamic tabs that you can open at one time is 10.

When a record is open in a dynamic tab, associated records are shown as nested tabs. For example, when you open an account record as a top-level dynamic tab and then drill into the primary contact or an associated service request, these linked objects are displayed in nested dynamic tabs.

Nested tabs make it easy to quickly navigate across and between grouped records without losing context. Nested tabs are particularly useful for chat agents who have multiple, simultaneous interactions.

To open an associated record as a nested tab, click the object link that can be opened as a nested tab in the service work area. When you open a record in a nested tab, that record automatically becomes the active tab. The maximum number of nested tabs that you can open at one time is 5.

Under each open top-level dynamic tab, you can open the following objects as nested tabs:

- Account
- Contact
- Asset
- Custom Object
- Other Service Requests
- Activities
- Linked Knowledge Articles
- Work Orders

The nested dynamic tabs contain the following buttons:

- **Save**: Saves any data changes and the user stays on the same page.
- **Save and Close**: Saves any data changes and closes the tab. This button is displayed only on the first nested tab you open. After you open an addition tab, it will be hidden on all nested tabs.
- **Cancel**: Discards any data changes and closes the tab. In the Service Request Details page, if there are unsaved changes, the user is notified of any unsaved changes.

When you try to close an unsaved nested tab, a warning message alerts you about the unsaved changes.

You can close the top-level dynamic tab and all the nested tabs at one time by clicking the x icon on the top-level dynamic tab name. When you have unsaved changes in a nested tab and move away from the tab, a blue dot appears next to the tab label, and a message appears when you hover over the label to indicate this status. When you try to close a dynamic tab with unsaved changes in its nested tabs, a warning message alerts you about any unsaved changes.
When you use Global Search (on top of the page), and then select a search result, if that item can be viewed within a dynamic tab, then a new dynamic tab is opened within the current workspace for the selected record. This improves the productivity by preserving the current layout of other tabs in the Workspace (or SR work area) including any unsaved data while using the Global Search feature. You must have the privilege to use dynamic tabs within the Workspace, else the Global Search feature will display the search result in the same dynamic tab.

**Note:** To enable the global search, an administrator must set the system profile option, FUSION_APPS_SEARCH_ENABLED to Yes. For more information about enabling the system profile option for global search, see the online help and the Getting Started with Your Sales Implementation guide. To know more about how to configure Workspace and use Workspace, refer the Oracle CX Sales Guides.

**Related Topics**
- Enable and Use Cobrowse

**Service Request Summary Page Options**
When you start creating an SR, the Create Service Request page displays three buttons: **Save and Continue**, **Save and Close**, and **Cancel**.

After you enter a title and save the SR, or open an SR for editing, the page also displays the **Actions** menu. The following table lists and describes the available actions in the **Actions** menu.

<table>
<thead>
<tr>
<th>What would you like to do?</th>
<th>How to do it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter simple and consistent resolution information about the SR</td>
<td>Select <strong>Resolve</strong>.</td>
</tr>
<tr>
<td>Assign the SR to yourself</td>
<td>Select <strong>Assign to Me</strong>.</td>
</tr>
</tbody>
</table>
| Make a copy of an existing SR.  
**Note:** You can configure the Copy SR action to include the custom fields on the SR object. This enables all non-empty custom fields to be automatically populated in the destination SR. For more information on how to configure the custom fields for the copy action, read the Implementing Service Guide. | Select **Copy**. |
| Delete an SR | Select **Delete**.  
This option is available only to administrators. A deleted service request can't be retrieved, and the delete action can't be undone. |
## What would you like to do? | How to do it
--- | ---
Forward an SR to another user of the application | Select **Forward**.
Assign a queue to the SR | Select **Run Queue Assignment**.

### Related Topics
- Create a Copy Map

### How You Use the Actions Menu
Use the **Actions** menu on the **Edit Service Request** screen to take action on the SR. Let's look at some examples of actions available in the **Actions** menu.

<table>
<thead>
<tr>
<th>What would you like to do?</th>
<th>How to do it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter simple and consistent resolution information about the SR.</td>
<td>Select <strong>Resolve</strong>. This displays the Resolve Service Request dialog box.</td>
</tr>
<tr>
<td>Assign the SR to you.</td>
<td>Select <strong>Assign to Me</strong>.</td>
</tr>
<tr>
<td>Create a new SR with the same details as the current SR.</td>
<td>Select <strong>Copy</strong>. You can also use this feature for custom fields; you don't need to re-enter the field values if the fields were populated on the source record prior to invoking the copy action. To do this, you must configure the Copy Service Request action to include custom fields on the service request (SR) object. To know more about this, read the topic, Create a Copy Map in the Implementation Guide.</td>
</tr>
<tr>
<td>Delete the SR.</td>
<td>Select <strong>Delete</strong>.</td>
</tr>
<tr>
<td>Forward the SR to another user in the application.</td>
<td>Select <strong>Forward</strong>.</td>
</tr>
<tr>
<td>Create an internal note on the SR in the <strong>Messages</strong> tab.</td>
<td>Select <strong>Internal Note</strong>.</td>
</tr>
<tr>
<td>Create a response message in the <strong>Messages</strong> tab.</td>
<td>Select <strong>Response</strong>.</td>
</tr>
<tr>
<td>Copy the link to the SR. You can paste this link in your messages or use it to access the SR directly on the browser.</td>
<td>Select <strong>Get Link</strong>.</td>
</tr>
<tr>
<td>Assign the SR to a queue immediately.</td>
<td>Select <strong>Run Queue Assignment</strong>.</td>
</tr>
<tr>
<td>What would you like to do?</td>
<td>How to do it</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Update and refresh the SR milestones.</td>
<td>Select <strong>Update Service Request Milestones</strong>.</td>
</tr>
<tr>
<td>Launch a Cobrowse session with the customer. The Cobrowse feature enables you to see the customer's screen and what they're working on. This feature is available only if it's configured by your administrator.</td>
<td>Select <strong>Launch Cobrowse</strong>.</td>
</tr>
<tr>
<td>Add plans to the SR.</td>
<td>Select <strong>Add Plans</strong>.</td>
</tr>
<tr>
<td>Add individual actions to the SR.</td>
<td>Select <strong>Add Actions</strong>.</td>
</tr>
<tr>
<td>Follow the SR and receive all notifications for that SR. Notification followers receive notifications for all supported channels, when any notification event is triggered for the SRs they follow. This feature is available only if it's configured by your administrator. At least one notification trigger must be enabled for follower as a type of recipient for an SR notification.</td>
<td>Select <strong>Follow</strong>.</td>
</tr>
<tr>
<td>Un-follow the SR record if you don't want to receive notifications for that SR.</td>
<td>Select <strong>Unfollow</strong>.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Enable and Use Cobrowse

**How you View Interaction History for the Service Request**
If you're an agent or manager, use the Interaction History view to:

- Track interactions related to a specific account, contact or service request.
- Track all customer communications across channels.
- View the total number of interactions, most-used channels, and contacts that were involved in the interactions.

To display the page you just go to the Edit Service Request page, and click the **Interaction History** tab.

On this page, you can filter interactions by channel, contacts, resource, creation date, and the direction of the interaction. You can also bring up the **Wrap Up** page to view chat transcripts, and view real-time analyses of SR interactions.
Analyses | What does the Analyses provide
---|---
Interactions | Gives an overview of the volume of interactions for the SR. This tile displays the following information:
  - The total number of interactions for that SR.
  - The number of interactions over the last 10 days.
Top Channels | Shows the top three most used channels for interactions on an SR
Top Contacts | Shows the top three team users with the highest number of interactions. The interaction individual total is shown with each user name.

You can view interactions that are linked to a service request, lead, and opportunity. These details are indicated in the Reference Type column.

**How You View the SR Milestones**

A milestone is a significant event in your service request resolution process. Milestones are based on the service level agreements defined for your business, and they help you identify your compliance with these agreements. When you create a service request, the related milestones are applied automatically based on the service entitlements assigned to the customer.

The **Milestone Details** tab on the Edit Service Request page lists all milestones with the due dates and warning thresholds. Milestones are updated and refreshed automatically.

- Use the **Show** drop-down list to filter the milestones you want to view.
- Click a milestone to view more information. The milestone details display the thresholds set for the milestone and the current status of the milestone.
  - A red alert icon on the milestone indicates that the due date has passed.
  - A yellow warning icon on the milestone indicates that it’s approaching its due date.
  - A green icon indicates that the milestone was successfully completed.
- Use the **List** icon to view the completed and upcoming milestones in a table.
- Use the **Timeline** icon to view all milestones in a timeline graph.
  - Use the slider on the timeline to view the milestones by hours, days, weeks, or months.
- To refresh the milestone details manually, click **Actions** and select **Update Service Request Milestone Configuration**.

**Deep Links for Service Requests**

Deep links are links that point to another page. You can link to a page where users can create a new service request, or edit an existing service request. Read this topic to learn how to construct these links. Once you have a link, you can then send it to someone else, or you can manually add the link to any page, such as to a report or user interface page.

This topic covers:

- Deep linking methods
- Get Link method
• Manual URL method
• Where can you use these links?
• How user authentication provides secured access to the target page.

Deep Linking Methods
To create deep links to service request pages, you can use one of two methods.

• Get Link method
  Use this method to easily "get a link" to the details page (edit page) of any service request.
• Manual URL method
  Use this method to link to any service request page. Link to where users can create a new CRM or HR Help Desk service request, or link to the details page of an existing service request.
  This method is useful because you have the flexibility to specify parameters in the URL itself, so that you can link to exactly the page you want. For example, link to a page where the user can create a service request for a particular account and product group.

Get Link Method
The Get Link method is the simplest method to obtain a deep link, but it works only for service request details pages (edit pages). To obtain an automatically generated deep link:

1. Navigate to the details page (edit page) of the service request that you want to link to.
2. Click Actions > Get Link.
3. Copy the link by clicking Control + C.
4. Share that link.

Manual URL Method
You must use the manual URL method to link to a service request create page, or to link to a specific subtab other than the summary tab on a details page. To link to a details page with the summary subtab in focus, you can use this method but the Get Link method is simpler.

To use the manual URL method, choose from four URL patterns to build your deep link. In each pattern, you can specify a variety of parameter values to satisfy the particular needs of your "create service request" business case. Depending on the link that you build, your users can navigate to the create page for the service request, or to a specific record.

To link to a page where your users can create new CRM service requests, use the following syntax:

• https://<hostname>:<port>/fscmUI/faces/deeplink?objType=SVC_SERVICE_REQUEST&action=CREATE_IN_TAB

To link to a page where your users can create new HCM service requests, use the following syntax:

• https://<hostname>:<port>/fscmUI/faces/deeplink?objType=SVC_SERVICE_REQUEST_HCM&action=CREATE_IN_TAB

To link to an existing CRM service request (in this example, service request SR0000033095), use the following syntax:

• https://<hostname>:<port>/fscmUI/faces/deeplink?objType=SVC_SERVICE_REQUEST&objKey=srNumber%3DSR0000033095&action=EDIT_IN_TAB

To link to an existing HCM service request (in this example, service request SR0000033095), use the following syntax:

• https://<hostname>:<port>/fscmUI/faces/deeplink?objType=SVC_SERVICE_REQUEST_HCM&objKey=srNumber%3DSR0000033095&action=EDIT_IN_TAB
You can link to specific subtabs (in this example, the Messages subtab) using this syntax:

- \( \text{https://<hostname>:<port>/fscmUI/faces/deeplink?objType=SVC\_SERVICE\_REQUEST\&objKey=srNumber\%3DSR0000033095\&selectedSubTabName\%3DMessages\&action=EDIT\_IN\_TAB} \)
- \( \text{https://<hostname>:<port>/fscmUI/faces/deeplink?objType=SVC\_SERVICE\_REQUEST\_HCM\&objKey=srNumber\%3DSR0000033095\&selectedSubTabName\%3DMessages\&action=EDIT\_IN\_TAB} \)

**Tip:** Copy the first part of the URL, \( \text{https://<hostname>:<port>/} \), from your instance’s actual home page.

**Note:** The deep links don’t work if they contain the \# character. Also, special characters such as @, ^, and * can be used only if preceded with the backslash character \. For example, you must use \* instead of * in your regular expression. For more information about using special characters in regular expressions, see the open source documentation for regular expressions. After you modify the regular expression, remember to use a validator to ensure that it’s still working.

This table lists of the components of the service request deep link pattern.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>objType</td>
<td>SVC_SERVICE_REQUEST</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SVC_SERVICE_REQUEST_HCM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use SVC_SERVICE_REQUEST to link to CRM service requests.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use SVC_SERVICE_REQUEST_HCM to link to HCM service requests.</td>
<td></td>
</tr>
<tr>
<td>objKey</td>
<td>Here’s a list of the available fields (attributes) for the objKey parameter which you might typically want to use.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When linking to the create page, you can pass any and all of the fields listed below. Additionally, you can use all fields, including custom fields, that are exposed for the service request object. If using custom fields, be sure to use the custom field’s API name, not display name, in the deep link URL.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When linking to the edit page, pass only the srNumber parameter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When linking to the create page, you can add multiple fields for the objKey parameter to prepopulate values onto the create page. For example, in a single URL, you could specify both a product ID as well as a primary contact ID to prepopulate onto the create service request page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When linking to the create page, you can specify more than one pair for the objKey parameter by using the &amp; symbol.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The objKey takes key value pairs. Specify both the field and the field’s value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: objKey=accountId=123&amp;primaryContactId=456&amp;partnerAccountPartyId=789</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The objKey parameter is optional and is typically used for record identifiers.</td>
<td></td>
</tr>
</tbody>
</table>

<p>| srNumber  |                        | |
| srID      |                        | |
| accountid (or accountPartyId) |                        | |
| primarycontactid (or primaryContactId) |                        | |
| productgroupid (or productGroupId) |                        | |
| productid (or inventoryItemId) |                        | |
| partneraccountid (or PartnerAccountPartyId) |                        | |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>assetid</code> (or <code>assetId</code>)</td>
<td></td>
</tr>
<tr>
<td><strong>selectedSubTabName</strong></td>
<td><code>Messages</code></td>
<td>To link to the Messages subtab, use this value: <code>Messages</code></td>
</tr>
<tr>
<td></td>
<td><code>Interactions</code></td>
<td>To link to the Interaction History subtab, use this value: <code>Interactions</code></td>
</tr>
<tr>
<td></td>
<td><code>Contacts</code></td>
<td>To link to the Contacts subtab, use this value: <code>Contacts</code></td>
</tr>
<tr>
<td></td>
<td><code>Team</code></td>
<td>To link to the Team subtab, use this value: <code>Team</code></td>
</tr>
<tr>
<td></td>
<td><code>Activities</code></td>
<td>To link to the Activities subtab, use this value: <code>Activities</code></td>
</tr>
<tr>
<td></td>
<td><code>LinkedArticles</code></td>
<td>To link to the Linked Articles subtab, use this value: <code>LinkedArticles</code></td>
</tr>
<tr>
<td></td>
<td><code>Milestones</code></td>
<td>To link to the Milestone Details subtab, use this value: <code>Milestones</code></td>
</tr>
<tr>
<td></td>
<td><code>Parts</code></td>
<td>To link to the Part Details subtab, use this value: <code>Parts</code></td>
</tr>
<tr>
<td></td>
<td><code>WorkOrders</code></td>
<td>To link to the Work Orders subtab, use this value: <code>WorkOrders</code></td>
</tr>
<tr>
<td></td>
<td><code>Audits</code></td>
<td>To link to the Audit History subtab, use this value: <code>Audits</code></td>
</tr>
<tr>
<td></td>
<td><code>Conversations</code></td>
<td>To link to the Social subtab, use this value: <code>Conversations</code></td>
</tr>
<tr>
<td></td>
<td><code>ActionPlan</code></td>
<td>To link to the Action Plan subtab, use this value: <code>ActionPlan</code></td>
</tr>
</tbody>
</table>

The `selectedSubTabName` parameter is optional. Use this parameter to link directly to a subtab in an existing record.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>action</strong></td>
<td>CREATE_IN_TAB</td>
<td>Open the Create Service Request page in dynamic tab mode.</td>
</tr>
<tr>
<td></td>
<td>EDIT_IN_TAB</td>
<td>Edit an existing service request in dynamic tab mode.</td>
</tr>
</tbody>
</table>

Assigning These Links
You can add deep links to:

- Reports

  Use BI Composer or BI Answers to add deep links to your reports.

- User interface pages

  Navigate to the service request object's Actions and Links node in Application Composer, and create an action or link using the deep link that you want. Then, use Application Composer to add the action or link to the object's user interface pages.

- External third-party applications

  Create a deep link to link directly to a service request page.
User Authentication for Secured Access
The deep link servlet requires authentication. If you haven't been previously authenticated, you must sign in to gain access to the target page. After signing in, you're redirected to the target page. If you have already been authenticated at the time of clicking the deep link, the target page is immediately displayed (without asking you to sign in).

Related Topics
- Actions and Links

Contacts and Team Members

Add Contacts to a Service Request
Add one or more contacts to the service request. Any contact you add to an SR can view and update the SR.

1. Click the Contacts subtab.
2. Click Add Contacts.
3. Enter your search criteria if relevant contacts exist your database, and select one or more contacts to associate with the SR. Click Apply to add them to the list of contacts.
4. If relevant contacts don't yet exist in your database, click Add Contact and then click Create Contact. For more information about creating a contact, see Oracle CX Sales Using Sales Guide.
5. After adding the contacts, click OK to return to the SR page.

Note:
- If you want to make one of the contacts the primary contact, click the Select Primary icon. You can change the primary contact by clicking a different contact, but you can't delete a primary contact. The Delete option is disabled for the primary contact.
- If two contacts are merged, you may see a change in the primary contact of an SR. The contact remaining after the merge is now associated with the SR, as it replaces the merged contact.

Add a Primary Contact to a Social Service Request
If a service request is received through a social channel, the application uses the social handle to determine the author. If you associate a social SR with a primary contact, the Create Contact Point dialog box displays, and clicking Create adds the social handle of the post author as the contact point of the primary contact. Once a social contact point exists for a contact, all SRs created for social posts from that user are associated with a primary contact.

Add Team Members to a Service Request
It's easy to add team members to a service request. Just click the Team tab on the Edit Service Request page to see the members of your team that are already assigned, then use the following procedure to add new members, or, if necessary, remove members. One thing you can't do, though, is remove the SR's primary contact.

1. On the Team tab, click Add Team Members.
2. On the Add Team Members page, search for the user that you want to add.
3. Select one or more users that you want to add from the Search Results section.
4. Click Apply to add the users to the team.
5. Click OK to close the Add Team Members page.

After you add users to the team, you can assign the SR to a specific user by selecting the Assigned To column for the user.
Create and Edit Service Request Lists

This example shows how you create a list specific to SRs from only those accounts where you're listed as a team member.

1. On the Service Requests screen, select Create or Edit Lists in the List drop-down list.
2. In the Advanced Search panel, select the saved search that you want to use for the list.
3. Select the attributes and values that you want to see in your list. To add more attributes, click Add and select the attributes that you want to set for the list search. You can reorder the order of these attributes by clicking Reorder.
4. Click Search to view the results.
5. Click Save to save the list and search values for the list.

Tags

Tags for Service Requests

Tags are keywords or terms that you can assign to Service Requests (SRs). Tags help you describe, classify, or organize SRs based on your requirement.

Here's how you can tag SRs:

- Associate tags when you're creating or editing an SR.
- Associate predefined tags to an SR or define new tags at runtime.
- Add multiple tags to an SR.
  Adding multiple tags gives you the flexibility to self-organize SRs without modifying the main category hierarchy.

Benefits of Tagging

When tags are associated appropriately with SRs, you may find them useful in many ways:

- Your search for SRs becomes easier and more accurate. For example: Searching across SR categories or products.
- Resolve SRs with the help of similar SRs if a suitable knowledge article isn't available.
- Assign SRs to appropriate queues based on the tags associated with the SRs.
- Refer to tag values in Groovy script and object workflow logic.

Associate a Tag with a Service Request

You can associate tags with a service request (SR) only if the Tag field is added to the layout of the following pages:

- Create Service Request
- Edit Service Request

If the Tag field isn't available when you create or edit SRs, contact your administrator.

You can use uppercase and lowercase alphabets and the digits 0 to 9 in a tag. A tag can have a maximum of 60 characters.

To associate a tag with an SR:

1. While creating or editing an SR, in the Tag field, type the name of the tag that you want to associate with the SR.
   As you start typing, a list of existing tags that contain the typed letters show up.
2. Do one of the following:
   ◦ If you find one of the existing tags to be suitable, then select the tag.
     The selected tag is associated with the SR.
   ◦ If no suitable existing tag shows up, then completely type the tag name that you want and click **Create Tag**.
     A new tag is created and associated with the SR.

   **Note:** To select an existing tag, you can also click the drop-down list in the **Tag** field and click **Search**. In the **Select Tag** dialog box, select the tag that you want from the displayed list and click **OK**.

### Search for SRs with a Specific Tag

To search for SRs associated with a specific tag:

1. On the Service Requests lists page, click **Advanced Search**.
2. In the **Advanced Search** dialog box, click the **Add** drop-down list.
3. Search for and select **Tag**.
4. In the first field, select **Equals**.
5. In the next drop-down list, type the tag for which you want to search the associated SRs.
6. Click **Search**.

The SRs associated with the tag that you specified are displayed.

### Remove Tags from a Service Request

After you create a new tag and associate it with SRs, you can remove the tag at any time later if the tag isn’t required or if it has a typo.

To remove a tag from an SR:

1. On the Service Requests List page, in the **List** drop-down list, select **All Open Service Requests**.
   All the open SRs are displayed.
2. Click the SR Reference Number for the SR from which you want to remove the tag.
   The Edit SR Summary page is displayed. The existing tags are listed below the **Tag** field.
3. Click **Remove** next to the tag that you want to remove.
4. Click **Save and Close**.

The tag is removed from the SR.

   **Note:** After the tag is removed from all the associated SRs:
   - The tag is deleted automatically if it’s user-defined and not created by an administrator.
   - The tag isn’t deleted if it’s created by an administrator. The tag still exists and can be associated with SRs again.

### Activities

#### Overview of Service Request Activities

Keep track of things that you plan to do for an SR in the Activities tab. Create tasks, appointments, or log completed calls as a part of your service request resolution process.
Use the Activities tab in the Edit Service Request page to create and maintain:

- **Tasks.** Think of these as to-do items assigned to people or groups. Tasks are also used to record completed customer interactions that weren’t scheduled in your calendar as appointments.
- **Appointments.** These are calendar events, such as a meeting with another person, or a scheduled phone call.
- **Log a call.** Record a brief summary of a call made for the SR. Calls can be created from an appointment, a task, or as a standalone activity on the Activity list page. When a call is created from a task or appointment, all pertinent data is auto-populated onto the call report.

**Related Topics**
- Get Started with Activities

### Messages and Social Interactions

#### Service Request Message Types

The Messages tab on the Edit Service Request page is where you compose and send messages to customers or team members.

Here’s the different message types that you can create for an SR:

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Entry</td>
<td>Capture SR information provided by customers. Customers can enter this information directly, or you can enter it while interacting with the customer.</td>
</tr>
<tr>
<td>Forward</td>
<td>Forward a customer response or query to any other user of the application. Use the Channel drop-down list and select a mailbox or an email channel, or a Slack channel or user to send the message.</td>
</tr>
</tbody>
</table>

**Note:** To forward an SR to a Slack channel or user to collaborate with a subject matter expert, see “Compose Messages”.

You can also forward an SR to a custom channel. If you use a custom channel, the implementation of how the message is delivered to the user on a custom channel is your company’s responsibility.

<table>
<thead>
<tr>
<th>Internal Note</th>
<th>Use internal notes to communicate with your other team members who have access to your SRs.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use the Reply button to enable team members to respond to the internal note, and create a conversation thread. These entries aren’t visible to customers since they’re associated to internal notes. You need not perform any additional setup or configuration to use this feature.</td>
</tr>
<tr>
<td></td>
<td>The team members use the Edit button (pencil icon) on the internal note created by them to make changes to their entry. If an internal note has one or more replies, use the Hide Replies link to collapse the replies, and the Show Replies link to expand the replies.</td>
</tr>
</tbody>
</table>
## Compose SR Messages

When you compose a new message, you can use SmartText entries and knowledge articles in your message text, and add attachments as part of the message. You can sort your messages using the Sort icon, or filter them using the different filters available in the Filter bar.

1. On the Messages tab, select Compose and select the type of message that you want to create.

   A new message form opens.

2. Depending on the message type that you choose, select the select channel type from the Channel drop-down list and Channel instance if required, and the recipient for the message.

   - For a customer entry, select the customer contact for whom you're creating this message.
   - For forwarding a message, select the recipients of the message in the To field, and optionally in the Cc and Bcc fields.
   - For creating an internal note, you aren't required to add recipients.
   - For creating a response, select the channel type, channel, and recipient.

   **Note:** Only enabled channels are displayed for selection.

3. Click the Add Attachment icon or click Select from Service Request to add an attachment to the message. Attach a file or a URL to your messages and enter a title and description for the attachment. To attach more than one item, click Add.

   **Note:**
   - Attachments aren't supported if you're responding through a social channel.
   - If your administrator has set the ORA_SVC_ENABLE_INBOUND_INLINE_ATTACHMENT_CATEGORY and SVC_INBOUND_ENABLE_INLINE_ATTACHMENTS profile options to Yes, images and logos (in the sender's signature) are displayed inline within the body of the service request message. They won't show up as regular service request attachments in the Attachments field of the Service Request Summary page.
   - When you add an attachment to a service request or to an SR message, don't select the Inline Attachments option from the Category drop-down list in the Attachments dialog box.

4. Enter the content of the message.

   - Use rich text formatting, except for social channel responses. Currently images and icons aren't supported for social responses.
   - Insert a SmartText entry by placing the cursor where you want the entry inserted, then type the # symbol, and then begin typing the SmartText entry name. Press the Tab key to autocomplete the SmartText name, or use the navigation arrows on your keyboard, and then press the Enter key.
   - Insert relevant knowledge articles into the message text by clicking Insert Knowledge or use the Knowledge subtab in the Right Panel. You can also type the knowledge article number into the message before posting the message. After you post the message, the knowledge article appears as a link in the message, and clicking the link opens the knowledge article in a new nested tab.
Inserting knowledge article links is not supported for responses using the social channel.

5. If the channel type is Email:
   
a. Search and select validated addresses. Autosuggestion functionality enables you to automatically populate email IDs without entering full details.
   
b. Click the **plus icon** next to the To, Cc, or Bcc fields, and select any of the menu options:
      
      - Select **Add Additional Email Addresses** to add new email recipients who aren't contacts or resources (team members). Enter the email IDs in the text box displayed, and separate them with semi-colons, commas or spaces. Ensure that you include an @ in the email ID. You can add such addresses in To, Cc, or Bcc. Once you have sent the message, the new addresses are listed in the **View Recipients** field.
      
      - Select **Add Contacts and Team** to include all the contacts and team members of the service request in your email response. You can add such recipients in To, Cc, or Bcc. Only recipients with a valid email ID are added. You can delete a recipient by clicking **Delete** (the x icon) on that recipient's name.

      **Note:** To enable the **Add Additional Email Addresses** and **Add Contacts and Team** features, your administrator must set the **SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS** profile option to **Yes**.

   c. Select an existing application contact from the email recipient list. This will allow users to add an SMTP address in the same message recipient list, even when the email ID isn't associated with a contact record. If a system contact isn't included in the recipient list, the user won't be allowed to add the SMTP address. You must include at least one system contact.

   d. Click **Preview Email** link to display the To, Cc, and Reply-to values along with any attachments. If the administrator has defined email templates in the Application Composer, the preview displays the composed message in the defined format. If no template is defined, the preview displays only the message as composed by you.

6. If you want to forward the message to a Slack channel or user to collaborate with subject matter experts:
   
a. From the **Channel** drop-down list on the Edit Service Request page, select **Slack**.
   
b. From the next drop-down list, select the name of the Slack workspace to which you want to forward the SR.
   
c. From the **To** drop-down list, select the name of the user or Slack channel to whom you want to forward the SR.

   You can also just start typing the name and select the user or the Slack channel from the displayed list.

7. Click **Send** or **Post** to send the message.

   **Note:** The reply from Slack is displayed as a thread below your forwarded message in the Messages tab. Similarly, when you reply to a Slack message, your reply is displayed as a threaded message in Slack.

To edit the text of the Internal Note and Customer Entry SR messages that you have previously created and posted, your administrator must enable the **SVC_ENABLE_MESSAGE_CORRECTION** profile option. For more information about profile options, see "Profile Options for SR Management" in Related Topics.

### View and Filter Messages

After you have composed a message, you can view the message in the **Messages** subtab. Each type of message is displayed in a different background color and with a different icon to enable you to easily identify whether the message was sent by an agent or customer, or whether it's an internal message. You can also identify the channel used, such as email or phone.
Here’s how you can filter messages using the Filter tab in the Messages subtab:

- Use the Collapse All and Expand All buttons on the message list.
- Use the toggle button (with the arrow icons) to toggle between the Oldest First and Newest First messages. The Newest First is the default view.
- Use the one-click filter buttons to filter messages based on the following types:
  - **Customer**: Click the toggle button to view or not view all types of customer messages. Use the drop-down list to view or not view customer entries, forwards, and responses.
  - **Internal**: Click the toggle button to view or not view all types of internal messages. Use the drop-down list to view or not view chat transcripts, internal notes, and wrap ups.
  - **System**: Click the toggle button to view or not view all types of application messages. Use the drop-down list to view or not view application notes and application responses.
- Use the Reset Filters icon to turn on all filters, which is the default state.

**Related Topics**
- SR Management Profile Options

**How You Interact With Social Posts**

All social posts display the customer’s social media profile picture. Click the social profile icon to display the number of followers on the social network for that profile.

A few things to keep in mind:

- If your SR social post message is public, you can only respond with a public message.
- If the user’s incoming social post is private, you can only send a private response to the user.
- If you have both a public and private social post from the user, you can choose whether to respond with a public or a private post.
- For posts that enforce a character limit, use Application Composer and add a script to validate the maximum number of characters in your response.
- For social posts where a social channel response is disabled, change the channel type to email for your response message.

For inbound messages, the Customer Entry messages for an SR display the photos and videos attached to social posts in Oracle Social Cloud. Inbound messages of this type are supported for public and private messages on both Facebook and Twitter social networks. These attachments are URLs that you can click and view.

- Public messages, images, and videos open in Facebook or Twitter, when you click the URL attachment.
- Private messages open in Social Cloud when you click the URL attachment. You must sign in to Social Cloud to view the attachment image or video.

**Search and Update**

**Advanced Search on Service Requests**

Use advanced search to narrow down search results by entering more specific criteria. For example, if you want to see all the open SRs that are assigned to your subordinates and are in progress, do the following:

1. Click the Show Advanced Search button.
2. Select **All Open Service Requests** in the **Saved Search** field.

3. For the **Record Set**, select **Equals** and **Assigned to my subordinates**.

4. For the Status, select **Equals** and **In Progress**.

5. Optionally, click **Add** to add more search criteria.

6. Optionally, click **Save** to save the search for future use.

7. Click **Search** to see the search results.

### Search for Service Requests Assigned to a Person Who Is No Longer a Resource

When a resource leaves the organization or moves to another department, the service requests (SRs) assigned to this resource must be reassigned to another resource by their manager. But after the resource has left or moved, let's say you do an Advanced Search and use the **Assigned To** search. The search doesn't work and their name doesn't show up. Instead, you can use the **Assigned To Person Name** search. This way, the SRs assigned to the person are displayed even after they have left the organization.

To search for service requests assigned to a person who may no longer be available as a resource:

1. In the Navigator, click **Service > Service Requests**.

2. Click **Advanced Search**.

3. In the Record Set area, select **All records I can see**.

4. In the **Add** drop-down list, select **Assigned To Person Name**.

5. Type the name of the person and click **Search**.

The list of SRs assigned to the person are displayed, and they can be reassigned to another resource.

### Mass Update of Service Requests

To mass update service requests:

1. Select **Update** from the Actions menu.

2. Select the SRs you want to update. To select multiple SRs, hold down the **Ctrl** key and select each SR.

3. The **Update** button shows the number of SRs selected.

4. Click **Update** to view the Update Service Requests dialog box.

5. Select a field to be updated from the drop-down list and a value for the update.

   These are the fields that are exposed by default: Queue, Category Name, Assigned To, Status, Severity, and Problem Description. You can use Application Composer to add the additional out-of-the-box field, Critical, and you can also create and add custom fields.

   To add the additional default field or custom fields you have already created, see "Expose Additional Fields for Service Request Mass Update" in the Oracle Applications Cloud Configuring Applications Using Application Composer guide. To create custom fields, see "Defining Fields" in the Oracle Applications Cloud Configuring Applications Using Application Composer guide.

6. Click **Submit** to assign the queue to all the selected SRs.

### Order Parts

**How to Order Parts for Service Requests: For Oracle Service Logistics Cloud Users**

If parts are needed and a field service technician isn't required, you can order parts using the Parts tab on the Edit Service Request page.

When you add parts to an SR, a parts-only sales order is created and the part is shipped to the customer address. For more information, see the link to related topic about ordering replaceable parts.
Use IoT for Connected Assets

Diagnose and Troubleshoot Connected Assets
You use Oracle Internet of Things Service Monitoring for Connected Assets to securely connect different types of assets, register the assets’ resources and metadata, and deploy software applications on your registered assets. For more information about Internet of Things Service Monitoring for Connected Assets, see "Getting Started with Oracle Service Monitoring for Connected Assets" in Related Topics.

For a connected asset, when an incident is created in Internet of Things Service Monitoring for Connected Assets, an SR is created in Oracle B2B Service (the service application) for that connected asset. When the SR is resolved, the corresponding incident in Internet of Things Service Monitoring for Connected Assets is also closed.

Use the **Connected Asset** tab of the Edit Service Request page to diagnose and troubleshoot the asset associated with this SR, when this asset is connected through an instance of Internet of Things Service Monitoring for Connected Assets. On this tab, you can view information reported by the asset, query the asset for additional information, and remotely execute actions that are available for the asset.

To view the metrics or key performance indicators (KPIs) for the connected assets, click the **IoT Asset Details** link. The Oracle Internet of Things Asset Monitoring Cloud Service Map is displayed in a subtab, where you can track key asset data for your monitored assets, such as located assets, assets connected, assets available, assets utilization, and open incidents. The map view displays aggregate data for the assets currently displayed in the map.

On the map subtab, use the KPI ribbon to track cumulative metrics or KPIs for the assets displayed in the map view. You can search for a place or zoom into a location in the map to see the cumulative statistics for that location. The metrics are based on live data. A live metric value is refreshed every two minutes. The KPI ribbon in the map view can show a maximum of five metrics. To add a user-defined metric, you must remove a preexisting metric and add the new metric.

The following metrics or KPIs are displayed in the KPI ribbon, by default:

- **Located Assets**: Shows the number of assets located in the current view. This number may increase as you zoom out to include more places, or it may decrease as you zoom into the assets belonging to a specific place.
- **Assets Connected**: Shows the percentage of connected assets in the current view. An asset counts as connected if the application has heard from the asset sensors in the last one hour.
- **Asset Utilization**: Shows the percentage of used assets in the current view. An asset counts as used if the asset isn't available in its assigned storage place.
- **Asset Availability**: Shows the percentage of available assets in the current view. An asset counts as available if there are no open outage incidents reported for the asset.
- **Open Incidents**: Shows the number of open, or unresolved, incidents for assets in the current view. Incidents help identify issues, such as outages, for the maintenance staff to work on.

To track the metrics or KPIs for a specific asset, click the asset in the map view. The following asset metrics are displayed by default:

- **Currently Connected / Currently Not Connected**: Shows whether the asset is currently connected. You can select a time period to search for the percentage connectivity. For example, you can search for the percentage connectivity in the last 24 hours.
- **Currently Utilized / Currently Not Utilized**: Shows whether the asset is currently used. You can select a time period to search for the percentage utilization. For example, you can search for the percentage utilization in the last 24 hours.
• **Currently Available / Currently Not Available**: Shows whether the asset is currently available. You can select a time period to search for the percentage availability. For example, you can search for the percentage availability in the last 24 hours.

For more information, see "Monitor the Health and Usage of Your Assets" in Related Topics.

Use the **Actions and Attributes** section to view the attributes of the connected asset, remotely update the available values, and execute available actions, for troubleshooting and diagnosis. The available actions and attributes vary according to the signed in user’s role and the asset definition in the connected Internet of Things Service Monitoring for Connected Assets instance. For example, a connected refrigerator might have an action defined to cycle the power, and might let you remotely set the attribute for the target temperature to any value between 35 and 39 degrees.

- To execute an action on the connected asset, select an action from the **Asset Actions** drop-down list, and click **Execute Action**.
- To modify the attribute values, edit the values and click **Update Attribute**.

Use the **IoT Incident Details** section to view the Internet of Things Service Monitoring for Connected Assets incident details for which this SR is created. Connected assets regularly report status information and other data to the Internet of Things Service Monitoring for Connected Assets application. The Internet of Things Service Monitoring for Connected Assets application uses this data to detect problems indicating a failure has occurred or is imminent, and creates an incident. When connected to the service application, the incident triggers the creation of an SR to proactively resolve the issue.

Use the **Diagnostics** section to review the data reported from the asset in a line graph, and identify anomalies that may indicate the cause of the issue. For example, with a connected refrigerator, you might notice that the temperature started increasing a few data points after the motor slowed to half speed. Reviewing this data enables you to focus on why the motor slowed, as the root cause of the issue.

Here's what you can do to view up to 200 data points at a time in the line graph:

- To view data for a specific duration, enter or select the start date and time from which you want to view the data, in the **Display 200 Data Points From** field.
- To navigate to the previous and next set of 200 data points, click the **Previous** and **Next** arrow icons.
- To view the earliest available diagnostic data from Internet of Things Service Monitoring for Connected Assets, click the **Show earliest data** icon.
- To view the latest available diagnostic data from Internet of Things Service Monitoring for Connected Assets, click the **Show most recent data** icon.
- To view the data stream centered on the time the incident was created in Internet of Things Service Monitoring for Connected Assets, click the **Show data from time of incident creation** icon.
- To hide an attribute within the graph, click the attribute name on the graph. To view the attribute, click the attribute name again.

**Related Topics**
- Getting Started with Oracle Service Monitoring for Connected Assets
- Overview of Oracle Internet of Things Service Monitoring for Connected Assets
- Integrate B2B Service with Service Monitoring for Connected Assets
- Monitor the Health and Usage of Your Assets

Work with Action Plans
Add an Individual Action or an Action Plan to an SR

You can add individual actions or entire action plans to an SR if additional steps are required to resolve the SR.

To Add Action Plans:

Action plans are templates that contain multiple actions that are required to resolve an SR.

1. On the Edit Service Request page, Select **Add Plans** from the Actions menu.
2. Select one or more templates from the list, or search for a template using **Template** name, or **Category**.
   - To make sure the correct template is selected, the action plan preview displays when you highlight the template row.
3. Click the **Add (+)** icon for the template you want to add to the SR.
   - The template appears in the Templates to Add region. You can select and add multiple templates to the SR.
4. Click **Apply** to apply the template.

If the administrator designated the action plan template to start automatically, the action plan is started within a short period of time.

Otherwise, you can start the plan by clicking the **Start** button in the Status column.

Once the plan is started, you can start working on it.

To Add Individual Actions to an SR:

1. On the Edit Service Request page, Select **Add Actions** from the Actions menu.
2. In the Add Actions window, find the action you want to add to the SR.
3. Click the **Add (+)** icon to add the action to the Actions to Add list.
   - You can add multiple actions to an SR.
4. Click **Add Selected Actions**.
   - You are returned to the Actions and Plans page. You can see the actions you added are initiated.

**Note:** It might take a little time for the actions to start. Click **Refresh** to see updated statuses.

Add Additional Actions to an Action Plan

You have the option of adding additional actions to an action plan. Here's how you do it:

1. On the Actions and Plans page, click the **Add (+)** icon.
2. On the **Add Actions to Action Plan** page, select an action from the list, or search for an action using **Action Name**, **Category**, or **Type**.
3. Click the **Add (+)** icon for the action you want to add.
   - You can add the same action multiple times. For example, if an action needs approval multiple times, add the action for approvals as many times as you need to.
   - If you need to remove an action from the **Actions to Add** pane just click the **Delete (x)** icon.
4. Once you have added all the additional actions to the action plan, click **Add Actions**.
   - Actions added to the plan are inserted at the end of the plan and prerequisites can't be added for any actions that aren't added through a template.
Caution: Before you continue, make sure you have the correct plan and that all the actions are correct. After the plan is initiated, you can’t delete actions. If you need to start over, click Discard. The Discard button is your last chance to remove the plan.

Work with Action Plans

Use the Edit Service Request: Actions and Plans page to view and edit actions and plans.

1. Click the Actions and Plans tab in the Edit Service Request page.
2. Click the number for the action plan you want to edit.

On the Action Plan page, you can do the following:

Filter Plan Actions

You can use Quick Filter to view actions by:

- All Actions
- Active Actions
- Actions Delayed
- Actions without Prerequisites
- Actions Not Started
- Customer Visible Actions
- Blocked Actions

Edit Action Plans

To edit plans, click the number of the plan you want to edit. The Action Plan page opens to show all the actions on the plan.

1. Click the link of an Action name. It opens a page where you can make updates. For example, you can change status to Complete for a Service Request.
   
   If the action type is a dynamic process and you click the process name, a new window opens in the Process Automation application.

2. Update the End Dates if things aren’t getting done on time or if things are getting done early.

   Working with the End Dates:

   When an action is created, the estimated time it takes to complete a task is entered for the action. On an action plan, an end date for each action is based on the estimated time for the action.

   If an action is past due, a warning icon appears on the end date of the action showing that the deadline for the action has passed. In addition, the projected completion date shows a warning.

   You can change the end date of an action by using the End Date field.

   Once the date for the past-due action is corrected, the warning no longer appears.

3. If one of the actions in an action plan is optional and it’s not started, you can skip it by clicking the Skip icon.
   You can’t skip mandatory actions or change prerequisite actions.

4. Close the action when you’re done with changes and click Refresh to refresh the plan.
Add Additional Actions to a Plan

To add additional actions to an existing plan:

1. Go to the Actions and Plans tab on the SR.
2. Click the number of the plan you want to add an action to.
3. On the Actions and Plans Plan page, click the Add (+) icon.
4. Select an action from the list, or search for an action using Action, Category, or Type.
5. Click the Add (+) icon for the action you want to add.

You can add the same action multiple times. For example, if an action needs multiple approvals, you can add the action as many times as needed.
6. Click Add Selected Actions.

You’re taken back to the Actions and Plans page.

Note: If you have permission to create articles, you can create a Knowledge article based on the SR you’re working on. Search for the Article type as you did in the previous step and click Add Selected Items. Click the article name in the actions list. This takes you to the Knowledge Management application. Your administrator already mapped what fields from the SR go into the article. Complete any missing information and click Create. Now, a draft article is created. It goes through an approval queue and once it's approved, it's available for other agents to view as a possible solution to their SRs with similar problems.

7. Click Save or Refresh to start the plan you just added.
8. Click Save and Close.

View Action Plans

View an action plan using the default list view, or select the Diagram view icon to see a graphical version of the action plan.

- List View: Displays a table with the steps in the action plan. You can sort the columns in the table using the arrows in each column header.
- Diagram View: Displays a graphical view of the action plan timeline. This view shows the status of each action. You can also hover over each action to show prerequisites, dates for the action, and next steps.

FAQs about Action Plans

What's the difference between an Action and an Action Plan?

Action plans are a checklist, a series of events, or steps that have to be done before you can close an SR.

An Action is an individual event that needs to be done to close an SR. For example, maybe an appointment needs to take place with someone before the SR can be closed.

Adding actions or plans to an SR is easy. In an SR, select Add Plans or Add Actions from the Actions menu.
View Service Request Audit History

The **Audit History** tab shows you audit reports for a service request. You can filter reports by date, user and events, and export them to Excel.

**Note:** You can see the Audit History tab on the Edit Service Request page only if your administrator has done the following:
- Assigned the SVC_VIEW_SERVICE_REQUEST_CHANGE_HISTORY privilege to your role.
- Enabled the Audit History tab using Application Composer.

You can export the audit report from the **Audit History** tab to excel. The following procedure describes how to access an audit report.

1. In the **Audit History** tab, click the **Expand** icon.
2. Select a date range for your report.
3. Enter the other search details if required, such as user name and event type.
4. Click **Search**.
5. In the Search Results, select the report you want by clicking row.
6. Click **Actions** and select **Export to Excel**.

Save your search criteria by clicking **Save** in the Search section. Retrieve saved searches by using the **Saved Search** drop-down list.

Mobile Service Requests

How You Manage SRs on the Mobile Application

As a service representative, service manager, or a partner user, you manage service requests (SRs) in your Oracle CX Cloud Mobile application, on iOS and Android devices.

To access your SRs, tap the main menu icon on your Oracle CX Cloud Mobile application, then tap **Service Requests**.

The SRs list view displays a list of all open SRs.

Here's a few things you can do in the SRs list view:

- Search the SRs that you have access to, and filter and sort the SRs.
- Create and edit SRs.
- View SRs from different business units.
  - You can view multiple business units if your administrator enables the HZ_ENABLE_MULTIPLE_BU_CRM profile option. Products and categories are filtered based on the business unit you select.
  - For more information about business units, see the "Setting Up Service Business Units" Related Topic.
- Swipe an SR to do quick edits.
- Tap an SR to view the details, then use the tabs in the SR details view global footer to:
  - View and create appointments, tasks, and other activities. Tap an appointment or task on the activity timeline to view its details.
  - View and add contacts, team members, and accounts to the SR.
○ View and add messages to the SR.
○ View and add attachments to the messages and SR. You can also download attachments from messages to the mobile device.
○ View the interaction history for the SR. You can't create or edit interactions.

Interactions are logged for an account, contact, or service request. Use interactions to track inbound and outbound communications with a customer across channels such as SMS, phone, and email.

○ View the milestone history for the SR. You can't create or edit milestones, but you can filter the milestone list view.

Milestones represent the service level agreements (SLAs) that a service organization has with its customers. SLAs track against SRs and define commitments and deadlines for resolution. SLAs also help maintain the quality of customer service, and give an organization a metric to track performance.

Alternatively, you can also view the open SRs for a specific account or contact. Navigate to the details view of the account or contact you want to view, and then tap the Service Requests tab.

Related Topics
- Configure Oracle CX Cloud Mobile
- Oracle CX Cloud Mobile: Overview
- Setting Up Service Business Units

Partner Service Requests

How You Create Partner Service Requests

You create partner service requests (SRs) to capture and resolve issues that your partner accounts have reported. To work on partner SRs, you must be assigned one of these roles:

- Partner Sales Representative
- Customer Service Representative
- Channel Account Manager

If you're not assigned to one of these roles, talk to your administrator.

To create a partner SR, you just do one of the following:

- Select Service Request from the Navigator, then on the Service Requests list page, click Create Service Request.
- On the Partner Overview page, select Service Requests, and then click Create Service Request on the Service Requests tab.

In the SR, you also must enter a summary and you have the option of adding messages, contacts, and activities. You can also create a team to handle the SR and view linked articles and milestones.

Here are a few things that you can't do with partner SRs:

- Add partner resources to the SR Team.
• Assign the SR to a partner resource.
• Use a single SR to communicate to both the customer and partner.

External partner sales representatives and partner contacts can only view SR summaries and related messages. Internal customer service representatives or channel account managers who work on the SR can access all the SR subtabs.

Related Topics
• Profile Options for SR Management

Overview of Summary Details for Partner Service Requests

The summary details for your service request capture the basic information required for the service teams to understand the problem. Your administrator must configure the layout of this form to include partner-specific fields. While some of the fields are self-explanatory, the following table lists and describes the fields in the summary information section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>You select the product group or product associated with the SR.</td>
</tr>
<tr>
<td>Partner Account</td>
<td>For a partner user, the Partner Account field is set by default to the account that the user represents. If this field isn't already set, select a partner from the list. This field is mandatory.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>When you associate a partner account with an SR, the Primary Contact field is the partner contact associated with the partner account. If this field isn't automatically set, then search and select a partner contact.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Don’t create a new partner contact from the search dialog box. To create a new partner contact, go to the Partner Administration user interface.</td>
</tr>
<tr>
<td>Severity</td>
<td>The severity of the problem.</td>
</tr>
<tr>
<td>Critical</td>
<td>You select this option to include the service request in the reporting metric about critical SRs. It doesn’t affect the service request resolution.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates whether the SR status is new, in progress, resolved, waiting, or closed. When you create a new SR, the status is set to New.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the status of an SR is Closed, you can’t do the following: edit any field in the SR, add a message, or reopen the SR.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Enter a description for the problem. You can use a SmartText entry here.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Solution Description</td>
<td>The Solution Description field is available throughout the lifecycle of the SR. You can prepare notes and draft descriptions, and validate them before you formally resolve the SR. You can use a SmartText entry here.</td>
</tr>
</tbody>
</table>

Overview of the Actions Menu

When you start creating an SR, the Create Service Request page displays three buttons: Save and Continue, Save and Close, and Cancel. Once you enter a title and save the SR, or open an SR for editing, the page also displays the Actions menu. The following table describes the actions provided on the Create and Edit SR pages.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign to Me</td>
<td>You select this option to assign the SR to yourself.</td>
</tr>
<tr>
<td>Copy</td>
<td>You select this option to create a copy of this partner SR to create a new SR.</td>
</tr>
<tr>
<td>Delete</td>
<td>You select this option to delete a partner SR. This option is available only to administrators.</td>
</tr>
<tr>
<td>Forward</td>
<td>You select this option to forward the partner SR to any other user of the application.</td>
</tr>
<tr>
<td>Run Queue Assignment</td>
<td>You select this option to immediately assign the SR to a queue.</td>
</tr>
</tbody>
</table>

Overview of Partner SR Messages

You can send and receive attachments with the primary contact using Customer Entry and Response messages respectively. Just click the Messages subtab to open and view the messages in an SR.

The partner contact can send attachments using the Customer Entry message type. That attachment is visible only to the internal resource. The internal resource can share an attachment with the partner contact by including the attachment in a Response message.

| Note: The Customer Entry and Response messages are read-only for external partner roles. |

You can compose the following types of messages for an SR.

<table>
<thead>
<tr>
<th>Message Type</th>
<th>What You Need to Know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Entry</td>
<td>In a partner SR, the Partner Account is considered the customer. Customer entries capture details about a customer’s service problem or query. Depending on the input channel, this</td>
</tr>
<tr>
<td>Message Type</td>
<td>What You Need to Know</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td></td>
<td>information might be written directly by the customer, or transcribed by the agent while interacting with the customer.</td>
</tr>
</tbody>
</table>
| Forward      | You can forward a note to any other user of the application through one of the two following options:  
|              | • Send an email notification.  
|              | • Post a note to the SR message history. |
| Internal Note| SR owners can use internal notes to communicate with other team members who have access to the SR. A partner user can’t create internal notes, though. |
| Response     | You can compose a response message to communicate with the SR contacts. You can send the response to the contact in an email template, or post it to another channel through an Application Programming Interface (API). |

To edit the text of the Internal Note and Customer Entry SR messages that you have previously created and posted, you must enable the SVC_ENABLE_MESSAGE_CORRECTION profile option. For more information about profile options, see “Profile Options for SR Management” in Related Topics.

**Related Topics**

- Reassign or Reroute an Interaction
- Overview of Queues

## How You Create Partner Contacts

To create partner contacts, you must use the Partner's Administration UI. For more information about creating a contact, see Oracle CX Sales Implementing Sales.

## How You Create Service Request Activities

The Activities subtab is only available to internal users, such as customer service representatives or channel account managers, who have the View Service Request Team permission. To create an activity, you click the Activities subtab. From there you can create an appointment, a task, or log a call from the Activities page. For more information about activities, see Oracle CX Sales Implementing Sales.

## How You View Articles Linked to Service Requests

You view knowledge articles that are linked to an SR in the Linked Articles subtab. Just click the subtab to view. Linked articles are visible only if your administrator has configured and enabled the Knowledge feature. Also, only internal users such as customer service representatives or channel account managers who have the permission to view knowledge within a service request can view linked articles.
How You View Service Request Milestones

The Milestone subtab is on the Edit Service Request page. It is only available to internal users, such as customer service representatives or channel account managers, who have the View Service Request Team permission. View all milestones along with their due dates and warning thresholds on this tab.

You can filter the list to show only those milestones that you want to view. A red alert icon means that a milestone is past its due date. A warning icon means that a milestone is approaching its due date. An additional icon indicates that the milestone was successfully completed. Click the milestone to view more information. The milestone details display the thresholds set for the milestone and the current status of the milestone.

You can view milestones in either a table view or a timeline view. The table view displays the completed and upcoming milestones in a table. The timeline view displays all the milestones in a timeline graph. Use the slider on the timeline to view the milestones by hours, days, weeks, or months. Milestones are updated and refreshed automatically. To refresh the milestone details manually, you just click Actions and select Update Service Request Milestone Configuration.

Productivity Tools

Keyboard Shortcuts

Use keyboard shortcuts to streamline your work. View keyboard shortcuts from the Service Requests page by clicking the Actions menu, then selecting Show Keyboard Shortcuts. You can also access the shortcuts by typing Ctrl+Alt+H. Your administrator defines keyboard shortcuts.

There are two types of keyboard shortcut. Use Button Access keys to relocate the cursor or the focus of a selection to a specific, or frequently-used interface component, and to execute the action in a view. Action Command keys are direct keyboard shortcuts.

Button Access Keys

Button access key availability depends on your browser. The following table lists the combinations you can use on the latest version of each supported browser.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Operating System</th>
<th>Key Combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Chrome</td>
<td>Linux</td>
<td>ALT + SHIFT + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>Mac OS X</td>
<td>CONTROL + OPTION + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>Windows</td>
<td>ALT + SHIFT + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td>Linux</td>
<td>ALT + SHIFT + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td>Mac OS X</td>
<td>CONTROL + Key</td>
<td>Click</td>
</tr>
</tbody>
</table>
## Action Command Keys

Use the Alt+Control+Key keyboard shortcut combination for all actions on the user interface. This combination is applicable to both Windows and Mac OS X operating systems. Here, Key is the keyboard key defined for that particular action. The shortcuts are listed in the Actions drop-down list for each action on every page.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Operating System</th>
<th>Key Combination</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mozilla Firefox</td>
<td>Windows</td>
<td>ALT + SHIFT + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 7</td>
<td>Windows</td>
<td>ALT + Key</td>
<td>Set focus</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 8</td>
<td>Windows</td>
<td>ALT + Key</td>
<td>Clear or set focus</td>
</tr>
<tr>
<td>Microsoft Internet Explorer 11</td>
<td>Windows</td>
<td>ALT + Key</td>
<td>Clear or set focus</td>
</tr>
<tr>
<td>Apple Safari</td>
<td>Windows</td>
<td>ALT + Key</td>
<td>Click</td>
</tr>
<tr>
<td>Apple Safari</td>
<td>Mac OS X</td>
<td>CONTROL + OPTION + Key</td>
<td>Click</td>
</tr>
</tbody>
</table>

## Use Keyboard Shortcuts to Select SR Summary Values

Use this procedure to select the value in the Category and Product fields on the SR Summary page.

1. Press the Tab key until you get to the Product or Category field.
2. Press Alt+Down arrow key to open the list options.
3. Press Shift+Tab key to select the Search link and press Enter.
4. Press Tab to select the header row.

- **Note:** Press Shift+Tab to move out of the table.

5. Press the Down arrow key to highlight the record that you want to select.
6. Press Shift+Alt+K to click OK.

   The product or category is added to the field.

## Slack

**Collaborate with Slack Users to Resolve Customer Issues**

Slack is a team communication tool that facilitates synchronous communication across different devices. Regardless of whether the team is co-located or distributed, Slack provides an effective communication channel that’s easy to use.
Slack is integrated with Oracle B2B Service, and here's how you can benefit:

- Without leaving Oracle B2B Service, you can forward a service request (SR) to a Slack channel or user and collaborate with them to resolve the SR.
- You can communicate effectively among team members and subject matter experts to resolve SRs faster.
- Slack channels show SR information as it happens, and also have a link to the SR for easy access.
- The replies from the Slack users are captured as a message in the SR. Slack users send their replies by using the **Reply to Service Request** button in Slack.

For more information about how you forward an SR to a Slack channel, see the following topics:

- How You Compose Messages in a Service Request
- Compose Messages

**SmartText**

**Overview of SmartText**

A SmartText entry is a reusable fragment of text that you can use. SmartText saves time and effort by reducing your keystrokes while also improving the overall consistency of written communication. You can create your own SmartText entries, or use those that are already available for general use. You can also create SmartText entries in any supported language.

**Note:** You can use HTML to create SmartText entries in Service Request Message fields. Other SR fields, such as Problem Description and Solution Description only support plain text.

There are two kinds of SmartText:

- Private: You create these entries yourself and you're the sole user.
- Public: Public entries are available to all users.

SmartText entries can contain system variables and user-defined variables. System variables are public and can't be edited or deleted. User-defined variables are private, you can create, edit and delete them. For example, say you had a variable where you assigned "Service Request" as the object, and "Primary Contact" as the attribute. When this SmartText entry is used, the primary contact listed for the service request is automatically substituted for the variable in the text field.

**How You Use SmartText in Service Requests**

Use the SmartText tab by opening the Restore Pane arrow. You can enter SmartText in the Problem Description and the Solution Description areas of SRs. You can create SmartText in multiple languages.

**Note:** In previous releases, there was a **New SmartText** (+) icon in the Right Panel that enabled you to quickly create a new private SmartText. From release 21D onward, the + icon no longer exists. To quickly create a new, private SmartText, simply click the **Manage SmartText** (pencil) icon.

Create Private SmartText entries from:

- The Create Service Request page
- The Edit Service Request page
- The Tools Menu
To view the list of available variables, click **SmartText** and select **Manage SmartText** in the Service Request details page. Click the **User-Defined Variables** tab or the **System Variables** tab on the Manage SmartText page.

Create your own variables on the Manage SmartText page by clicking **New** on the **User-Defined Variables** tab. In the new row, enter a name for the variable and select the substitution type. Substitution type defines what happens when a user chooses to enter the variable. You can select the following substitutions:

<table>
<thead>
<tr>
<th>Substitution Type</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt:</td>
<td>Select when you want to be prompted to select a value when the variable is inserted. When using an entry with a Prompt substitution, you're prompted to select and enter the value of the variable in the field. For example, you create a prompt type variable for a Bug number. When the SmartText entry containing this variable is used, you're prompted to enter the bug number in the field where the field requires a value.</td>
</tr>
<tr>
<td>Evaluate</td>
<td>Select this type to automatically evaluate and substitute the value of the variable in the text. For example, you assign Service Request as the object and primary Contact as the attribute in the variable and insert this variable in your SmartText entry. So, when this SmartText entry is used, the primary contact listed for the service request is automatically substituted for the variable in the text field</td>
</tr>
<tr>
<td>Value</td>
<td>Select this type when you want a particular value to be inserted as the variable. For example, you create a variable for &quot;My Name&quot; and insert the value as your name. When the SmartText entry containing this variable is used, the value is automatically substituted as the name value you add in the variable.</td>
</tr>
</tbody>
</table>

To edit a user-defined variable, select the variable and update as required. To delete a user-defined variable, select the variable and click **Delete Selected Variable**.

**Insert a SmartText Entry**
To insert a SmartText entry just type the # character, then type the keyword for the SmartText entry that you would like to insert. Select from the results to insert the entry. You can also open the SmartText tab on the SmartText panel to view all the available entries.

If multi-BU is enabled, the list of SmartText entries will be limited to the business unit associated with the SR along with all the SmartTexts that are associated with the Null "No associated business unit value".

For information on creating private and public SmartText entries, refer to Related Topics.

**Related Topics**
- SmartText Naming Conventions
- Create and Edit Private SmartText Entries
- Create and Edit Public SmartText Entries
3 Knowledge

Use Knowledge with Service Requests

Use Knowledge with Service Requests

You can use Knowledge to help solve service requests by finding articles that are relevant to the service issue, linking those articles to the request, and sending the helpful information to the customer. When you open the Knowledge pane in a service request, you immediately get recommended articles based on the request's title, products, and categories. If the recommended articles don't resolve the issue, you can search for more articles until you find the content that you need.

You can keep a list of favorite articles, rate articles to show which ones are valuable and which ones need to be improved. You can also recommend new articles or updates to existing articles to continually improve knowledge base quality.

Access Knowledge in a Service Request

To access knowledge in a service request, open the Knowledge pane. The Recommended Answers tab shows you articles that are relevant to service request title and any additional product and category information. From here you can read articles, search for more articles, add knowledge to the service request, and manage your favorite articles list.

Search for Articles in a Service Request

If you don't see the article you need in Recommended Answers, you can search for more articles by entering new search terms, additional products and categories, and even multiple languages, if they are supported by your organization.

Be sure that you have set your preferred knowledge locale so that you get the best search results.

1. Select the search tab, and enter a search term.
2. Select a locale if you want to see results in a language other than your preferred knowledge locale.
3. Click the search icon.
4. Filter the search results by the request's categories or products if you need to.

Set a Preferred Knowledge Locale

Your preferred knowledge locale sets your knowledge base language. If you don't set a preferred knowledge locale, you will get knowledge in the default preferred knowledge locale set by the administrator. If the administrator has not set a default preferred knowledge locale, you will get knowledge in the locale that corresponds to your language and territory preferences.

Choose the locale that has the most articles that are useful to you. For example, let's say you live in France, but your organization's knowledge base articles are intended for users in the United States (en-US). Let's also say that your language and territory preference is set to French, France. If an administrator has set the default preferred locale to en_US, all of the articles are available to you.
If you do not set a preferred knowledge locale, then you will see knowledge in the default preferred knowledge locale set by the administrator. If the administrator has not set a default preferred knowledge locale, then no articles are available to you, because there are no French articles in the knowledge base.

1. Click the user icon at the top right and select Settings and Actions.
2. Select Set Preferences.
3. Select Preferred Knowledge Locale and select a locale from the menu.

Related Topics
- Default Preferred Knowledge Locale

Add Knowledge to Service Requests

There are a few ways to use knowledge to help resolve an SR. You can add text from the article, or add a link to the article. You can do it directly from the knowledge pane, from the article details window, or by using the insert knowledge option when you compose an SR message.

Link Articles to SRs

Link an article to an SR to help resolve an issue. Linking articles to SRs helps agents quickly find the right answers to resolve similar issues in the future.

1. Select the article that you want to link and click the Link article to service request icon.
2. Save the SR to complete the link. The link will not be active until you save the SR.

View Linked Articles

View the articles linked to an SR to see if they are relevant to the issue you are working on. Click the Delete icon to remove a linked article.

1. Click the Linked Articles tab in the SR.
   The linked articles window displays all articles linked to the SR.

Send Articles to Customer

You can send articles to customers by adding them as text or links in the SR. You can add them from the knowledge pane or from the article details window.

1. Open an SR and click the slider to open the knowledge pane.
2. Locate the article that you want to add to the SR. You can click the article to view the contents.
3. Click the Insert as Text icon if you want to insert the article as text in a response message.
   Click the Insert as Link icon if you want to insert the article link in a response message.
4. Select a channel type and edit the message as desired.
5. Click Send, or click Save to Draft.

Add Article Links to SR Messages

You can send articles to customers by inserting the article links into the SR message. You can only insert articles that are linked to the SR.

1. Open an SR in edit mode and click the Messages tab.
2. Select the message type that you want to send from the Compose drop down list.
The message pane opens.

3. Click **Insert Knowledge**.

The Insert Knowledge page opens and the articles that are linked to the SR appear.

4. Select the article that you want to insert, click the **Insert as Text** icon or the **Insert as Link** icon, and then click **Done**.

The article is inserted as text or link in the SR message depending on what you selected.

5. If you inserted the article as text, you can edit the article’s text as desired.

6. Click **Send**, or **Save to Draft**.

Save Links to Articles from the Knowledge Panel

You can copy the URL of an article to add to your bookmarks or share the URL with other agents or colleagues. You should avoid inserting these direct links into public facing documents because users must have access to My Knowledge to use the link.

1. Open an article in the knowledge panel.
2. Click the copy icon at the end of the title row to copy the article URL.

Add Articles to Favorites

Add articles as favorites for quick and easy access. Open an article, then click the **Star** icon. You can access your favorite articles in the Favorites section on the knowledge tab, and on the My Knowledge page.

Rate an Article

Rate articles based on their quality and usefulness. You cannot rate articles that you own. There are two types of ratings. Your site may use either the 5 Star type or the Like or Dislike type. The 5 Star type is the default. Choose a rating from the article details page.

Use My Knowledge

My Knowledge

My Knowledge is a convenient place that you can use to find knowledge articles. You can also use My Knowledge to see recently published articles and bookmark your favorite articles. My Knowledge is available to Service and HR Help Desk users, and there is also a general My Knowledge page that is available from the Knowledge menu.

You can access My Knowledge using these paths:

- If you are using Service, select **Service**, then **My Knowledge**.
- If you are using HR Help Desk, select **Help Desk**, then **My Knowledge**.
- If you want to use the general page, select **Knowledge**, then **My Knowledge**.
Set a Preferred Knowledge Locale

Your preferred knowledge locale sets your knowledge base language. If you don't set a preferred knowledge locale, you will get knowledge in the default preferred knowledge locale set by the administrator. If the administrator has not set a default preferred knowledge locale, you will get knowledge in the locale that corresponds to your language and territory preferences.

Choose the locale that has the most articles that are useful to you. For example, let's say you live in France, but your organization's knowledge base articles are intended for users in the United States (en-US). Let's also say that your language and territory preference is set to French, France. If an administrator has set the default preferred locale to en_US, all of the articles are available to you.

If you do not set a preferred knowledge locale, then you will see knowledge in the default preferred knowledge locale set by the administrator. If the administrator has not set a default preferred knowledge locale, then no articles are available to you, because there are no French articles in the knowledge base.

1. Click the user icon at the top right and select Settings and Actions.
2. Select Set Preferences.
3. Select Preferred Knowledge Locale and select a locale from the menu.

Related Topics
- Default Preferred Knowledge Locale

Search for Articles in My Knowledge

You can search in My Knowledge from Service, HR Help Desk, and Knowledge. You can search for articles in any locale that is supported by your application. If your administrator has enabled filtering, you can limit the search results in Service and HR Help Desk by product, category, or type of article.

In Knowledge > My Knowledge, you can't limit search results by product, category, or type of article. If you have access to more than one application, you can limit search results to the application that you are interested in before you search.

1. Enter the term in the Search field.
2. Click the Show Advanced Search icon if you want to select a locale other than your preferred locale.
3. In Service and HR Help Desk Applications, select a product, category, or content type if you want to limit the search results to these criteria.
4. Click the Search icon.

You can select an article from the search results to view its contents. The article view also contains information about the version, author, last update and publishing dates, and its rating.

Save Links to Articles in My Knowledge

You can copy the URL of an article to your clipboard and then paste the URL into a separate document to save it for later reference.

1. Open an article in My Knowledge.
2. Click the copy icon at the end of the title row to copy the article URL.
4 Assignments and Routing

Overview and Default Queue

Overview of Queues

Queues are a collection of work items. You use queues to channel work to the right agents for resolution. For example, you might want to have queues that channel work items to agents that meet these criteria:

- Work in certain locations, such as New Jersey
- Speak a certain language, such as Spanish
- Have a certain skill, such as ASE certification
- Work the night shift, or have a combination of many different skills

There are several pieces involved in how a work item gets to an agent to work on. You set up queues and assign agents to them. Then you assign work items to queues either manually or automatically. Finally agents manually pick up work items from the queue or are automatically assigned work items using Omnichannel.

You can enable or disable queues, and place queues inside other queues. You can also set the priority of each work item within a queue.

Related Topics

- Enable Omnichannel

Default Queue

If you have enabled Omnichannel, there's a ready-to-use queue named Default. You can set the Default queue to manual or automatic, depending on your company's requirement. Also, be aware that the Default queue contains work items that you can't place in any other queue because they don't match any of the defined assignment rules. You can add agents and teams to the Default queue and also modify the queue properties, but you can't disable or delete this queue.

Note:

- SRs that don't match any rules are assigned to the Default queue only when Omnichannel is enabled.
- When Omnichannel is enabled, here's what happens:
  - If you set the Default queue to automatic, then the work items are automatically assigned to the agents who are available and have free capacity.
  - If you set the Default queue to manual, then the agents must manually assign the work items to themselves. But you must remember that chats can't be assigned manually. So if chats are routed, then you must set the Default queue to automatic.

Here's what Oracle recommends:

- The preferred way of assigning an SR to a queue is by using Omnichannel assignment. Let's say you have enabled Omnichannel for SR assignments. And you may be assigning SRs to the Default queue either
manually or automatically by using assignment rules or groovy scripts. Either way, it's important and highly recommended that you assign active agents to the Default queue, so that SRs can be assigned to the agents.

- If you set the Default queue to automatic and you don't assign agents to it, SRs assigned to the Default queue could remain unattended and eventually impact performance. You could miss the SLAs and your customers don't get responses on time.
- If you don't assign any agents to the Default queue, then you must set the Default queue to manual. But if you set it to manual, you must ensure that the SRs are answered.
- Let's say you assign agents to the Default queue, but you prefer to use it as a catch-all queue and not for automatic assignment of SRs to agents. In such cases, you can set the default queue to manual. This would depend on your company's requirement.
- If you enable chat, it's absolutely necessary that you set the Default queue to automatic and assign agents to the queue. When the Default queue is automatic, all those chats that don't match any rules or they match a manual queue, are assigned to the Default queue. If you set the Default queue to manual, such chats aren't routed to any agent, and nobody would respond to those chats.

Related Topics

- Enable Omnichannel

Queues Dashboard

Overview of the Queues Dashboard

Use the Queues dashboard to view statistical data about all queues such as the assignment mode, the number of agents assigned, and those interactions waiting to be assigned. Drill down on a queue to view information about pending work items within the queue. Use this data to analyze and monitor routing. You can manually move interactions within a queue, to another queue, or you can assign the work item to an agent.

Work items can also be rerouted automatically based on assignment rules. If you click Reroute, and either the rules or properties have changed, the work item goes to a different queue. If the work item had previously been routed manually, rerouting assigns the work to the queue which corresponds to the automatic rules.

Once a work item is assigned to an agent, it’s no longer listed on the Queue Dashboard.

**Note:** The Queues Dashboard page is refreshed depending on the value you select in the Auto Refresh drop-down list. Also, the Queues Dashboard displays only pending interactions.

How You View Queue Information

The Queues table on the Queues dashboard lists statistics about both real-time and non-real-time work items.

<table>
<thead>
<tr>
<th>Field</th>
<th>What You Need to Know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The queue name.</td>
</tr>
<tr>
<td>Field</td>
<td>What You Need to Know</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the queue.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Tells you if a queue is enabled or disabled.</td>
</tr>
<tr>
<td></td>
<td>Select a value from the <strong>Show</strong> drop-down list to display <strong>Enabled, Disabled, or All</strong> queues.</td>
</tr>
<tr>
<td>Distribution</td>
<td>Specifies whether routing is automatic or manual.</td>
</tr>
<tr>
<td>Created</td>
<td>The date and time when the queue was created.</td>
</tr>
<tr>
<td>Agent</td>
<td>Lists the number of agents assigned to a queue, individually or as a part of a resource team.</td>
</tr>
<tr>
<td>Resource</td>
<td>Lists the number of resources assigned to the queue.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Resource</strong> link to open the <strong>Resources</strong> tab in the <strong>Queue Details</strong> window.</td>
</tr>
<tr>
<td>Resource Teams</td>
<td>Lists the number of resource teams that are associated with the queue.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Resource Teams</strong> link to open the <strong>Resource Teams</strong> tab in the <strong>Queue Details</strong> window.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Lists the number of work items that are assigned to an agent.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option selected from the Time Interval drop-down list. For example, to see the number of interactions that were assigned in the last 4 hours, select 4 Hours from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Waiting</td>
<td>Lists the number of work items currently waiting to be assigned, in the specified time interval.</td>
</tr>
<tr>
<td>Received</td>
<td>Lists the number of work items that came into the queue in the specified interval of time.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option selected from the <strong>Time Interval</strong> drop-down list. For example, to see the number of interactions that were received in the last 8 hours, select 8 Hours from the <strong>Time Interval</strong> drop-down list.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>Lists the number of work items that were abandoned in the specified interval of time.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option selected from the <strong>Time Interval</strong> drop-down list. For example, to see the number of interactions that were abandoned in the last 2 hours, select 2 Hours from the <strong>Time Interval</strong> drop-down list.</td>
</tr>
<tr>
<td>Real-Time Capacity</td>
<td>Specifies the percentage of the total capacity that's available to handle real-time work assignments.</td>
</tr>
</tbody>
</table>
### Chapter 4: Assignments and Routing

#### How You View Queue Channel Summary Information

The Channel Summary displays data related to all the real-time work items in the queue.

<table>
<thead>
<tr>
<th>Field</th>
<th>What You Need to Know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Real-Time Capacity</td>
<td>Specifies the percentage of the total capacity to handle non-real-time work assignments.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>What You Need to Know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-Time Channel</td>
<td>The type of a real-time channel.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The number of real-time notifications currently waiting to be assigned.</td>
</tr>
<tr>
<td>Assigned</td>
<td>The number of assigned real-time interactions.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option that's selected from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Average Wait Time</td>
<td>The average time period that a real-time interaction waited in the current queue before it was assigned to an agent.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option that's selected from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Received</td>
<td>The number of real-time interactions that were received.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option that's selected from the Time Interval drop-down list.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>The number of real-time interactions that were abandoned.</td>
</tr>
<tr>
<td></td>
<td>This value changes depending on the option that's selected from the Time Interval drop-down list.</td>
</tr>
</tbody>
</table>

#### How You View Queue Interactions Information

The interactions grid shows you details about all of the interactions in a selected queue. By default this grid only lists real-time interactions. To display non-real-time interactions, select the Show Nonreal-Time option.
## Work with Queues

### Create a Queue

You must be a service administrator or service manager to do this task.

1. Click **Navigator > Queues**.
2. On the Queues page, click **Create Queue**.
3. In the Create Queue dialog box, give the queue a name and, if needed, a description.
4. Select the **Enabled** check box.

   Your queue must be enabled before you can add work items to it.

5. For the **Distribution** option, select **Manual** or **Automatic**.
   - Select Manual if you want to add work items and assignments to this queue manually.
   - Select Automatic if you want Assignment Manager to do it for you.

### Field | What You Need to Know
--- | ---
Interaction | The date and time when the interaction was created.
Channel | The type of communications channel.
Reference ID | An identifier of the work item that’s associated with the interaction, for example, SR number.
Customer | The customer who started the interaction.
Account | The customer’s account.
Wait Time | How long the interaction has been waiting in the current queue. This value is reset each time an interaction is assigned to a new queue.
Number of Queues | The number of queues the interaction has been assigned to. When an interaction is moved from one queue to another, this counter increases by one. For example, if an interaction was moved to 3 different queues after it was created, the Number of Queues value is set to 3.
Rules Time | The time taken to assign the interaction to the current queue. This value is displayed in **HH:MM:SS.mmm** format.
Trace | Routing history of the interaction.
   - Click the **View** link to open the **Interaction Trace** window.
6. (Optional) The **Routing** option is applicable only if you select the Automatic distribution option in the previous step. Select one of the following:

   - Select **Use Omnichannel Routing** if you want to use the built-in Omnichannel routing for this queue. This option is selected by default.
   - Select **Use Third-Party Routing** if you want the work objects from this queue to be routed to a third-party routing service.

   **Note:** To use this service, you must register the partner. For more information about registering the partner using REST APIs, see the REST API for Oracle CX Sales.

   - From the **External Partner** drop-down list, select the partner.

7. (Optional) If applicable, select the **Assign pending interactions to overflow resources** check box.

   **Note:** Only if you select the **Use Omnichannel Routing** option, you can see the **Overflow Criteria** section of the page. This section is applicable only when you want to enable overflow resources for a queue.

   For more information, see "Add Overflow Queues to a Queue" and "Enable Overflow Resources for a Queue".

8. Do one of the following:

   - Click **Save and Close** if you're done.
   - Click **Save and Continue** if you want to add agents and teams to your new queue.

### Edit a Queue

You can rename a queue, enable or disable it, or set it to be manual or automatic.

Make sure you understand the consequences of the changes you're about to make, though. Refer to the Changing Queue Properties topic for more information.

1. Open the Queues list.
2. On the Summary page, click the queue name, and make your changes.
3. Click **Save and Close** to close the window after saving, or click **Save** to save without closing the window.

**Note:** You can see the audit trail of changes made to a queue in the Change History tab in the queue Summary page. But you can see the Change History tab only if your administrator has done the following:

   - Assigned the SVC_VIEW_QUEUE_CHANGE_HISTORY privilege to your role.
   - Exposed the Change History tab using Application Composer.
What Happens When You Change Queue Properties

Here's what happens when you change the properties of an existing queue.

<table>
<thead>
<tr>
<th>Change</th>
<th>What happens</th>
<th>What you need to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable an active queue</td>
<td>• The queue still appears in the UI in the Queues list. It doesn't appear in other locations, such as when editing an SR, or in searches during a queue assignment. • Assignment Manager continues to assign work items to the queue without assigning an agent (just like in a manual queue). • Any unassigned work items in the queue remain unassigned.</td>
<td>• Delete any assignment rules associated with the queue. • Manually assign any unassigned work items in the queue.</td>
</tr>
<tr>
<td>Change an automatic queue to manual</td>
<td>Any new or existing work items in the queue are no longer automatically assigned.</td>
<td>Manually assign these work items.</td>
</tr>
<tr>
<td>Change a manual queue to automatic</td>
<td>• Existing work items in the queue at the time of the change aren't routed automatically. • Any new work items that come into the queue are routed automatically.</td>
<td>Manually assign existing work items.</td>
</tr>
<tr>
<td>Rename a queue</td>
<td>Renaming a queue doesn't affect work items already in a queue. However, Assignment Manager will continue to assign work items to the renamed queue using the existing assignment rules.</td>
<td>You don't need to do anything.</td>
</tr>
</tbody>
</table>

Delete a Queue

You can delete a queue in most cases, but there are exceptions. You can't delete the default queue and queues with open work items and assignment rules.

To delete a queue, just do this:

1. Open the Queues list.
2. On the Summary page, click Actions, and then Delete Queue.
Search for a Queue

On the Queues page, you can search for specific queues based on any of the following criteria:

- Name
- Description
- Distribution type
- Whether the queue is enabled or disabled

1. On the Queues page, click the View drop-down list.
2. Click Query by Example.

A search row with boxes appears at the beginning of the list of queues.

3. In the search row, specify one or more of the following queue attributes:
   - Name of the queue
   - Description of the queue
   - Enabled, Disabled, or All, depending on the type of queue you're searching for
     - Click in the search box for the Enable column.
     - From the three options displayed, select the one that you want.
   - Distribution type of the queue: Auto, Manual, or All
     - Click in the search box for the Distribution column.
     - From the three options displayed, select the one that you want.

One or more queues that fulfill your selection criteria are displayed.

4. Select the queue that you want from the list.

Assign Agents

How to Assign Agents to Work Items

You can assign agents manually or automatically based on the Distribution option you select for the queue.

In a manual queue, the service manager or an agent with the right permissions assigns or reassigns each work item to an agent. Agents can also assign work items to themselves.

In an automatic queue, assignment of work items is automatic, based on assignment rules. Agents assigned to the queue can receive work items if they meet all of these criteria:

- Signed in to the application
- Available to accept work orders
- Have the capacity to take on more work

| Note: | Remember, you can use automatic queues only if your administrator has enabled Omnichannel. |
When you assign agents to multiple queues, be aware that capacity limits are calculated for individual queues. So, if you assign an agent to multiple queues they may get overloaded.

**Related Topics**
- Set Channel Capacity
- Define Queue Assignment Rules

## Agent Availability and Presence

### Set Presence and Availability

Work assignments are determined by your availability, so once you sign in to the application, set your presence and availability with the user menu.

You can explicitly specify your availability for real-time and non-real-time work items. This means that you can specify if you're available for chat or for an SR assignment, or for both. By default, you're shown as available for non-real-time interactions when you sign in.

Agent presence is different from availability in that it indicates only whether you're signed in to, and are working with, the application. Set presence in **Settings and Action** menu. Your status can be either Available or Busy, and you can toggle between statuses. The following table shows how work assignments based on availability and presence.

<table>
<thead>
<tr>
<th>Accepting Work</th>
<th>Presence</th>
<th>Work Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-real-time</td>
<td>Available</td>
<td>The SR is routed to the agent.</td>
</tr>
<tr>
<td>Non-real-time</td>
<td>Busy</td>
<td>The SR is routed to an agent and a notification is displayed. If the time-out period is nearing, a bold notification is displayed. Click the notification to accept the assignment. If you're presence is set to busy for an extended period of time, the SR is assigned to another agent. The availability to receive non-real-time work is also turned off.</td>
</tr>
<tr>
<td>Non-real-time</td>
<td>Offline</td>
<td>If the agent is signed out of the application, the status is set to offline. No new SRs are assigned, but the SRs that are already assigned are still owned by the agent.</td>
</tr>
<tr>
<td>Real-time</td>
<td>Available</td>
<td>Chat notifications are sent to the agent.</td>
</tr>
<tr>
<td>Real-time</td>
<td>Busy</td>
<td>Chat availability is turned off.</td>
</tr>
</tbody>
</table>
Note: If your administrator enables the SVC_OMNI_DISABLE_WORK_ITEM_AVAILABILITY_SELECTION profile option, you can't change your work and chat availability through the Omnichannel toolbar. Based on the profile option settings, the application assigns new work to you until your maximum capacity is reached. For more information, see "Enable Omnichannel".

Related Topics
- Enable Omnichannel

Queue Owners

Why You Assign a Queue Owner

Sometimes, you may have specific customer requests such as a request for information or creating a demonstration. Or, your company may have service requests (SRs) that can run a month or more. It's a good idea to manually assign such cases to the suitable resources.

For this, you need to assign queue owners for specific queues. When a new work item is assigned to a queue, the queue owner receives a notification. If required, he can override the automatic assignment of an SR and manually assign the SR to a specialized or specific resource. If he thinks that the automatic assignments are fine, he need not take any action.

Note: If you're a service administrator or service manager, you can assign owners to queues on the Queues page. Depending on your settings, you can also assign queue owners while creating or editing a queue.

You must complete the following processes:

- Add the Queue Owner field to the page layouts for queues (You need to do this step only once.)
- Assign a queue owner for a queue

Add the Queue Owner to the Page Layouts for Queues

You need to do this process only once.

To add the Queue Owner field to the page layouts for queues:

1. Sign in to the application as an administrator or setup user.
2. Within a sandbox, navigate to Application Composer.
3. In the Application field, select CRM Cloud from the drop-down list.
4. Search for Queue.
5. Click Standard Objects > Queue.
6. Click Pages.
7. Depending on your company's requirements, add the Owner field to some or all of the following page layouts for queues: Landing Page Layouts, Creation Page Layouts, and Details Page Layouts.
Assign an Owner to a Queue

Once you add the Queue Owner field to the queues page layouts, you can assign an owner to a queue anytime.

1. On the Queues page, select the name of the queue for which you want to assign an owner.
2. In the Name column, click the name of the queue.
3. In the Summary page, click the Owner drop-down list.
4. Search for and click the name of the owner from the displayed list.

   **Note:** You can also start typing the name that you're searching for, and click Search.

5. Click Save.

The queue is assigned to the owner that you selected.

**Note:** You can also assign a queue owner to a queue while creating or editing a queue, depending on how you modify your page layouts.

Queue Resources and Resource Teams

Add Resources to a Queue

1. Sign in to the application as a service administrator or a service manager.
2. On the Home page, click the Service group icon, and then click the Queues icon.
3. On the Queues page, click the queue that you want to update.
4. On the Summary page, click the Resources icon.
5. On the Resources page, click Add Resources.
6. On the Add Resources page, enter the search criteria such as the resource name.
7. Click Search.
8. Select the resources from the search results.
9. Do one of the following:
   - Click Apply to add the selected resources to the queue and stay on the same page.
   - Click OK to add the resources and leave the page.

Add Resource Teams to a Queue

You use a queue to group resources based on a specific criteria. Apart from adding individual resources to a queue, you can also add resource teams with specific skill sets that match the criteria.

1. Sign in to the application as a service administrator or a service manager.
2. On the Home page, click the Service group icon, and then click the Queues icon.
3. On the Queues page, click the queue that you want to update.
6. On the Add Resource Teams page, enter the search criteria such as the resource team name.
7. Click Search.
8. Select the resource teams from the search results.
9. Do one of the following:
   - Click Apply to add the selected resource teams to the queue and stay on the same page.
   - Click OK to add the resource teams and leave the page.

The resource teams are added to the selected queue.

Overflow Resources

Overflow Queues

You can add overflow or backup queues for every queue so that alternative resources are available when currently assigned resources are unable to keep up with incoming work or they aren't available. The waiting time for the customers is minimized by using a reserve pool of agents to handle the workload when required.

Here are some key points about overflow queues:

- Overflow queues can be added to every Omnichannel queue.
- You can add any number of overflow queues to a queue.
- Overflow queues enable you to bring in additional or backup resources dynamically when required.
- A work item is assigned to a resource from an overflow queue when required, but the item still remains in the current queue. The work item itself is never moved to the overflow queue.

Note: If no overflow queue resources are available, the work item remains pending in the current queue until a resource is available in the current queue or in one of the overflow queues.

Overflow queues are available for a queue only after you complete the following processes:

1. Add the overflow queues for a queue.
   See "Add Overflow Queues to a Queue".
2. Enable the overflow queues for that queue.
   See "Enable Overflow Resources for a Queue".

Factors That Determine the Selection of the Overflow Queue

The following factors determine the selection of the overflow queue:

- If more than one overflow queue is added, Omnichannel considers them in the priority order in which they're defined or added.
- Agents are considered only from those overflow queues which don't have any pending items, which means that the overflow queue has a spare capacity.
• If the first overflow queue doesn't have space capacity, the next one is considered, and so on.

Add Overflow Queues to a Queue

To add overflow queues as a backup for any queue:

1. Sign in to the application as a service administrator or a service manager.
2. On the Home page, click the Service group icon, and then click the Queues icon.
3. On the Queues page, click the queue that you want to add overflow queues to.
4. On the Summary page, click the Overflow Resources icon.

The Overflow Resources page is displayed. The overflow queues list is initially empty.
5. Click the arrow in the Select:Queue Name drop-down list.

The list of existing queues that are enabled, automatic, and are not routed externally, is displayed.
6. Search for and select the queue that you want to add as a backup queue.
7. Click Add.

The selected queue is added to the list of overflow queues. The priority value is one greater than the priority value of the last added queue in the list. For example, if the priority of the last added queue is 3, the fourth one is assigned a priority of 4. For the first queue that you add, the priority is 1.
8. Select and add more queues if required.

The Default queue isn’t added as an overflow queue by default. If you want to add the Default queue, you must add it from the Select:Queue Name drop-down list. The priority value is one greater than the priority value of the last added queue in the list.
9. Click Save.
10. (Optional) To reorder the priorities of the queues in the list, click the Up arrow to increase the priority or the Down arrow to decrease the priority.

Note: Queues with a lower priority value are considered first by Omnichannel as the overflow queue.
11. (Optional) To sort the list of overflow queues by name, click the Sort Ascending or Sort Descending arrows next to the Name column in the heading row of the list.
12. (Optional) To sort the list of overflow queues by priority, click the Sort Ascending or Sort Descending arrows next to the Priority column in the heading row of the list.
13. (Optional) To delete a queue from the overflow queues list, select the row and click Delete.
14. Click Save to save the changes and remain on the page or click Save and Close to leave the page.

Note: After you add the overflow queues, you must enable the overflow queues as described in the "Enable Overflow Resources for a Queue" topic.

Enable Overflow Resources for a Queue

After you add and save an overflow queue, you can enable or disable it at any time. Also, the saved configuration of the overflow queue applies each time you enable it, so you don't need to reconfigure it every time you use it.

For more information about how to add overflow resources to a queue, see "Add Overflow Resources to a Queue".
Here's some typical scenarios where you may need to enable overflow resources for a queue:

- Non-business hours when current resources may be unavailable.
- A holiday season when current resources have an increased workload but you still need to maintain customer SLAs.
- When queue behavior shows that your agents are unable to cope up with their workload.

Once enabled, you can choose from one or more conditions in which the overflow queues or resources are considered. When one of the specified conditions are met, Omnichannel expands the pool of agents to serve the current queue by including agents from overflow queues.

**Note:** You can edit a queue that's set as an overflow resource and disable it at any time. Once an overflow queue is disabled, it isn't considered when an agent is selected. The disabled queue does still appear in the list of overflow resources, though.

To enable overflow resources for a queue:

1. Sign in to the application as a service administrator or a service manager.
2. On the Home page, click the Service group icon, and then click the Queues icon.
3. On the Queues page, click the queue that you want to update.
4. On the Summary page, navigate to the **Overflow Criteria** section.
5. Select the **Assign pending interactions to overflow resources** check box.
6. Select one of the following conditions. When the selected condition is met, the overflow resources are used by the queue:
   - **When no human agent is immediately available**
   - **When actual wait time exceeds threshold**
     - **Real-Time:** Enter the number of seconds that must pass before a pending real-time interaction is assigned to an overflow resource. Real-time interactions include chats and videos.
     - **Non-Real-Time:** Enter the number of hours that must pass before a pending non-real-time interaction is assigned to an overflow resource. Non-real-time interactions include service requests.
   - **When number of pending interactions exceeds threshold**
     - **Real-Time:** Specify the threshold limit for the number of pending real-time interactions. When this limit is exceeded, the pending interactions are assigned to an overflow resource.
     - **Non-Real-Time:** Specify the threshold limit for the number of pending non-real-time interactions. When this limit is exceeded, the pending interactions are assigned to an overflow resource.

**Audit Trail for Queues**

**Enable Creating an Audit Trail for Queues**

You can create an audit trail of changes made to the business objects related to skill-based routing. By default, only certain fields of the queue object are audited. If you want more fields to be audited, you must add them. You can also do an audit for the child objects by doing some configuration. Similarly, you must enable the audit for any administrator-defined child objects that you create from Application Composer.
To enable the audit for additional fields or the child objects of the Queue object:

1. Sign in to the application as a setup user or administrator.
2. Navigate to the Setup and Maintenance work area.
3. Open the Tasks panel tab and click **Search**.
4. In the **Search** window, search for and click the **Manage Audit Policies** task.
5. On the Manage Audit Policies page, click **Configure Business Object Attributes**.
6. On the Configure Business Object Attributes page, select **Service** from the **Product** drop-down list.
   All the objects that can be audited are displayed. This includes the administrator-defined objects or administrator-defined child objects for ready-to-use entities created using Application Composer.
   For the Queue object, the **Audit** check box is selected by default. The subset of attributes that can be audited are also displayed.
7. Click **Add**.
8. In the **Select and Add Audit Attributes** dialog box, select the check box next to the attribute that you want to add, and click **OK**.
9. To add attributes to audit for each ready-to-use or administrator-defined child object of the Queue object, select the check box next to the object.

   **Note:** The ready-to-use child objects and administrator-defined child objects of the Queue object are displayed. For each of these child objects, one or more attributes are audited by default.
10. Repeat steps 7 and 8 to add more attributes.
11. Click **Save and Close**.

Enable Viewing the Audit Trail for Queues

To enable viewing the audit trail for queues in the queue Summary page, you must expose the Change History tab using Application Composer. For more information, see the Common Components Subtabs topic in the Oracle Applications Cloud Configuring Applications Using Application Composer guide.

**Note:** A user can view this subtab on the queue Summary page only if their role has been assigned the **SVC_VIEW_QUEUE_CHANGE_HISTORY** privilege.

**Related Topics**
- Common Component Subtabs

Individual Capacity Settings

Why You Override Individual Capacity Settings

Capacities for agents are set at the same global level. However, if you're a customer service manager, you can override the global maximum capacities and set maximum capacities for individual agents. So, you can allocate more work to agents with higher skills and efficiency, and keep workloads lighter for newer agents, or those still in training. Another common scenario is when a queue owner reviews reports and sees a requirement to increase chat capacities to improve Key Performance Indicators.
The Edit Capacities page displays the capacities for both real-time and non-real-time work items that can be handled by agents. You can modify the capacities on this page by overriding the default capacities.

**Note:** You can modify the capacities only if your administrator has enabled the ability to override individual capacities. For more information about setting channel capacities and enabling override of individual capacities, see the Oracle CX Service Implementing B2B Service guide.

### Key Benefits

Overriding individual capacity settings is good for the following reasons:

- You can search for individual agents or teams and modify their capacities.
- You can select a queue, review the capacities for the individual and team resources associated to the selected queue, and then, if you want, override the individual default capacities.
- You can filter the list of agents in a team, and view a list of only high performing agents who can manage more chat offers.
- You can receive in-line or bulk capacity updates for agents that you select.
- You can retain individual capacity changes if the individual capacity override capability is disabled.

**Note:** If the individual capacity override capability is disabled, your overridden capacities are reset to the global values. But, the modified values are saved in a table. If the capacity override is enabled again, the overridden capacity values that were saved are applicable again.

### Related Topics

- Set Channel Capacity

### Override Individual Capacity Settings

To override individual capacity settings:

1. Sign in to the application as a customer service manager.
2. On the Home page, click the Service group icon, and then click the **Queues** icon.
   
   The Queues dashboard is displayed.
3. Click the **Capacities** button.

   The Edit Capacities page displays information in the following format:

   - **Agent Name:** Name of the agent.
   - **Teams:** Name of the team to which the agent belongs.
   - **Queues:** Names of the queues to which the agent is assigned.
   - **Service Request (n):** Maximum number of service requests that the agent can handle. The number n within brackets is the global default capacity.
   - **Chat (n):** Maximum number of chats that the agent can handle. The number n within brackets is the global default capacity.
   - **Video (n):** Maximum number of video chats that the agent can handle. The number n within brackets is the global default capacity.
   - **Last Updated:** Date and time when the capacities for the agent were last modified. If the capacities for multiple channels were updated for the agent, the modification date and time for each channel are displayed separately.
4. Select individuals or teams to modify their channel capacities:

   o To select an individual:
     i. Click the **Agents** drop-down list and click **Select Individuals**.
        The Add Agents page is displayed.
     ii. Search for an agent by specifying the first name, last name, or other criteria provided on the page. You can also use a combination of multiple criteria.
     iii. Click **Search**.
        The list of agents matching your search criteria is displayed in the Search Results section.
     iv. Select the agents who you want to add and click **OK**.
        The selected agents are added to the list in the Edit Capacities page.

   o To select a team:
     i. Click the **Agents** drop-down list and click **Select Teams**.
        The Add Teams page is displayed.
     ii. Search for a team by specifying the team name or other criteria provided on the page. You can also use a combination of multiple criteria.
     iii. Click **Search**.
        The list of teams matching your search criteria is displayed in the Search Results section.
     iv. Select the teams that you want to add and click **OK**.
        The agents who are members of the selected teams are added to the list in the Edit Capacities page.

5. Review the capacities of the agents in the list.
6. To edit the capacity for service requests, chats, or videos for an agent in-line, click the Up or Down arrows to increase or decrease the capacity respectively.

To edit the capacities for multiple agents in bulk:

   a. Select the agents and click **Edit**.
      The Edit dialog box is displayed.
   b. Modify the capacities as required and click **Save and Close**.
   c. If you want to set the capacities back to the default values, click **Set to Default**.

7. (Optional) If you don't want to make any changes for some of the agents in the list, select those agents and click **Remove**.

To remove a single agent from the list, click **Remove** in the row.
8. (Optional) To revert the changes made to the capacities of one or more agents in the list:
   a. Select the check box at the beginning of the row for each of those agents.
   b. Click Set to Default.

   If the capacities of the selected agents were overridden or if you had modified them on this page, they're again
   set to the default global capacities.

9. Do one of the following:
   o Click Save to save the changes and remain on the page.
   o Click Save and Close to save the changes and exit from the page.
   o Click Cancel if you decide to discard the changes that you made.

Related Topics
   • Set Channel Capacity

Interactions

Reassign or Reroute an Interaction

You can reroute an interaction, move it to another queue, or assign it to a different agent.

You must be a service administrator or a service manager to do this task. Before you begin, consider these points:

   • You can manually assign an interaction to an agent regardless of that agent’s current capacity. But if the
     interaction is in real-time, the agent can decline it.
   • The agents listed in the Assign To drop-down list include offline agents. So, before you reassign a real-time
     interaction, make sure the agent is present and available.
   • For example, you have an assignment rule that reassigns all critical assignments to queue N and you reroute a
     critical interaction. The application automatically assigns the interaction to queue N. And remember, rerouting
     implies two actions: queue assignment or reassignment and Omnichannel routing, distribution, or assignment
     to an agent (which may occur immediately depending especially on resource availability and capacity).

   Note: If the interaction or work item is already assigned to a queue, it can potentially be removed from the queue
   if the latest queue assignment rules would cause it to be assigned to another queue. It can also be assigned to the
   default queue.

1. Click Navigator > Queues.
2. In the Queues page, click the row for the queue that has the interaction you want to change.
3. Select an interaction from the Interactions table.
4. To move the interaction to another queue:
   a. Select a queue in the Move To drop-down list.
b. Click **Move**.
   The interaction is moved to another queue.

5. To manually assign the interaction to a specific agent:
   a. Select an agent from the **Assign To** drop-down list.
   b. Click **Assign**.

6. To reroute the interaction, click **Reroute**.
   
The **Wait Time** value for the interaction is reset. See the creation date and time to determine the overall age of the interaction.
5 Chat

Overview of Chat

Sometimes, the easiest way for a customer to get help is through a real-time chat. The way it works is, a customer first initiates a chat from the Digital Customer Service portal. A notification is sent to the available service representatives in your service application. The assigned service representative then helps the customer in the Live Window that opens in their browser.

To receive chat requests, you must set your availability on the toolbar.

Set Your Availability for Chat

To set your availability for chat:

1. On the Service Requests List window, navigate to the chat icon in the toolbar.
2. Move the mouse over the chat icon to view the tool tip that displays your availability status for chat.
3. Click the chat icon in the toolbar to be available for chat.

   The tooltip displays: Available for chat interactions. The chat function is enabled.

4. When you don’t want to be available for chat, click the chat icon again to turn off your availability status.

When you set your availability, the Live Window opens in a new browser window. You can manage your chats in the Web Channels tab in the Live Window.

Note: If your administrator enables the SVC_OMNI_DISABLE_WORK_ITEM_AVAILABILITY_SELECTION profile option, you can’t change your work and chat availability through the Omnichannel toolbar. Based on the profile option settings, the application assigns new work to you until your maximum capacity is reached. For more information, see "Enable Omnichannel" in Related Topics.

Related Topics

- Enable Omnichannel

Chat Notifications

If the Live Window is open, the Incoming Chat notification appears in the Live Window and on the desktop. If you don’t have the Live Window open, the Incoming Chat notification appears only on the desktop.

- An incoming new chat request notification is displayed for 30 seconds by default.
- An incoming new chat message notification is displayed for 5 seconds.
- The default time-out duration for chat inactivity is 30 minutes.
Chat with Customers

When a customer initiates a chat request, an incoming chat window appears with the name and email of the person requesting the chat. The timer on the incoming chat window indicates the amount of time you have to accept or decline the chat. If the timer runs out, the chat is routed to another agent in the queue.

If your service application screen isn't active, an HTML notification is displayed in the task bar.

To chat with a customer on an incoming chat:

1. Click **Accept** in the incoming chat window to accept the chat.
   
   The **Contact Verification** window appears with the contact details.

2. Do one of the following:
   
   - If the customer details match the details on the Contact Verification page, click **Verify and Continue**.
   - If the customer details don't match, click **Search Again**.
     
     i. In the Contact Search page, search for a contact or create a new contact if the record doesn't exist.
        
        For more information, see "Searching for a Contact: Procedure".
        
        After a new record is selected, the Contact Verification page is displayed again with the new record.
     
     ii. Verify the record.

   After the contact is verified, the screen pop page is displayed as a top-level dynamic tab. Customer details appear in nested dynamic tabs. Business objects supported by nested tabs for Live Window are accounts, contacts, assets, and work orders.

3. Add or modify details on the screen pop page.
4. To view the Live Window again, click the interactions icon on the toolbar.

   The interactions icon on the toolbar also displays the number of active interactions that you have.

5. You can now engage in a conversation with the customer.

**Note:**

- You can accept multiple chat requests simultaneously. For more information, see "Switch Among Different Chat Conversations".
- If your administrator enables the SVC_CHAT_CKEDITOR_ENABLED profile option, you can do the following:
  
  - Format your text.
  - Insert images and content from Microsoft Word and Microsoft Excel.
  - Make use of the other available style formatting options.
  
  For more information about this profile option, see "Set Chat Profile Options".

6. (Optional) If you require assistance, you can transfer the chat to a queue so that another agent continues the chat. For more information, see "Transfer a Chat to a Queue".

**Related Topics**

- Set Chat Profile Options
Switch Among Different Chat Conversations

If you accept multiple chat requests, then multiple corresponding screen pop tabs are displayed. You can switch among the different chat conversations.

When you switch to a different active chat conversation in Live Window, the corresponding screen pop tab is displayed in the application. The converse is also true. When you switch among dynamic tabs on the Service Requests page, the corresponding Live Window chat conversation becomes active.

Transfer a Chat to a Queue

Let's say you require assistance with a chat. You can transfer the chat to a queue so that another agent continues the chat.

1. Before you transfer the chat, type a suitable message such as follows: I am transferring your chat to another agent.
2. Click Transfer in the Live Window.
3. Click Transfer to Queue.
   The Transfer drop-down list displays a list of automatic push queues where agents are signed in and have the capacity to take on additional work.
4. Select a queue by typing the queue name in the Search box or scrolling through the list.

   Note: If none of the agents in the selected queue is available or they don't have free capacity, a message is displayed, and you must select another queue.
5. After the chat is transferred successfully to a queue, an agent in the destination queue accepts the chat.
   The Contact Verification window is displayed, and the transferee agent can view the customer details.
6. The transferee agent must click Verify and Continue.
7. The transferee agent, using the Live Window, views the complete chat transcript of your discussion to date with the customer, and continues the chat.

Wrap Up a Chat

After you finish a chat, the Chat Wrap Up window appears if it's enabled. You can use this window to record any details from the chat. These details are stored in a wrap-up record. Refer back to these details at any time to track progress or review the history of a particular interaction.

The wrap-up details include the following types of contextual information:

- Total interaction time and channel type icon
- Agent who first handles the interaction
- Account name, title, email, and phone
- Reasons for the chat
• Whether the issue was resolved
• Any interaction notes that you want to enter
• Business objects that were updated during the interaction, which can include one or more service requests (SRs). The associated items are displayed as links to the titles of the SRs.

**Note:** A complete chat transcript between you and the customer is also captured and saved in the interaction wrap-up record or in the associated SR message. This is useful because even if chat wrap up is somehow disabled, you can still review a full transcript of your chat.

To wrap up a chat, perform the following steps in the **Chat Wrap Up** window:

1. Specify a **Communication Reason** by selecting an option from the drop-down list.
2. Select a **Resolution Code** to specify the type of resolution that was provided.
3. Specify a **Transfer Reason** if you transfer the chat to another agent for resolution.
4. Enter **Interaction Notes** to specify the details of the issue and the resolution that was provided. You can also document any other details that must be mentioned as part of the service interaction record.
5. Click **End Wrap Up**.

If the **Chat Wrap Up** window times out before you enter all the details, or if you want to add further notes, you can still add them later.

**Related Topics**

- Set Presence and Availability

### View Chat Wrap Up and Transcript

Use the Interaction History tab to view the wrap-up details and chat transcript. You can open the Interaction History tab from an account, contact, and service request (SR) record. To view chat details, drill into the associated wrap-up record for the chat interaction. The **Chat Wrap Up** window displays the chat details.

The chat transcript is correctly associated with the corresponding SR only if one of the following conditions are met:

- The SR account details match with the account details of the customer contact who initiates the chat.
- The primary contact for the SR initiates the chat.
- The agent who interacts with the customer on chat is the same agent who last updated the SR.

**Note:** To view the chat transcript, click **Show Transcript** in the **Chat Wrap Up** window. Now, suppose the chat wrap-up is disabled for a chat interaction, and you’re working with an SR. In such cases, you can review the chat transcript using the SR transcript message.

### Delete Chat Transcripts to Comply with General Data Protection Regulation (GDPR)

Sometimes, your customers may request you to delete a chat conversation for various reasons related to data protection and privacy. They may have shared their personal information through chat while resolving an issue or otherwise. And later they may want you to delete the information. If they’re located in the European Union (EU), they’re
governed by General Data Protection Regulation (GDPR) regulations. One of the GDPR regulations is the right to erasure or the right to be forgotten. In such cases, you can manually delete the corresponding chat transcripts.

**Note:** If you're an administrator, you have the privilege to delete chat transcripts. But if you have any other role, you can delete chat transcripts only if your administrator has added the privilege to your role. If you're unable to delete chat transcripts, you must contact your administrator.

To manually delete chat transcripts:

1. Open the Interaction History tab from the relevant account, contact, or service request (SR) record.
2. Drill into the associated wrap-up record of the chat interaction for which you want to delete the transcript.
3. The **Chat Wrap Up** window displays the chat details.
4. Click **Show Transcript** to view the chat transcript.
5. Confirm whether this is the transcript that you want to delete.
6. Click **Delete** to delete the chat transcript.

**Note:** After you delete the chat transcript, the interaction and wrap-up record is retained. But the chat transcript shows a blank window and displays the message **Chat Transcript Deleted**, along with the deletion date.
6 Computer Telephony Integration (CTI)

Handle Incoming Calls

When an incoming call is detected, the notification process involves multiple stages.

1. Receive incoming call notification.

You (the agent) are notified of an incoming call through a toolbar notification, and if configured, through a notification message box. If you're on a window other than the Oracle applications window, a toast notification is also sent to you.

2. Accept the call.

When you accept the call, you can use call controls to put a call on hold, end a call, or transfer the call to another agent. After you accept a call, if the phone number of the incoming call is registered or if the details provided through the IVR are recorded in the database, basic customer details are displayed in the Contact Verification page.

3. Click Verify and Continue.

If customer-provided details match the details on the Contact Verification page, you click Verify and Continue.

If the customer details don't match, click Search Again. In the Contact Search page, search for a contact or create a new contact if the record doesn't exist. For more information, see "Searching for a Contact: Procedure". After you select a new record, the Contact Verification page displays the new record. Verify the record.

4. Add or modify details on the screen pop page.

After the record is verified, the screen pop page displays details of the customer in a top-level dynamic tab with supporting nested dynamic tabs. You can add or modify details here. The business objects supported by nested tabs for Live Window are accounts, contacts, assets, and work orders.

5. Enter call resolution on the Wrap Up page.

After the call ends, the Wrap Up page is displayed, if enabled. Enter the call resolution details on the page, and click Save and Close. If the wrap-up is timed, you must wrap up before the specified time limit. If the time runs out, you can add wrap-up details in the interaction history.

All incoming and outgoing calls are recorded in the interaction history of the customer record.

Overview of Contact Search in CTI

You use the Computer Telephony Interface (CTI) contact search to search for a contact when there is an incoming call. The contact search enables you to do the following:

- Search for the contact record of the caller by specifying a contact attribute, such as a phone number or an email ID.
- Select a contact record from a list of records that are displayed based on a pre-filled caller information, such as a phone number. This information can be derived from an IVR system.
Search for a Contact in CTI

You must perform the following steps when there is an incoming call, and the contact search is displayed:

1. If data is prefilled in the contact search and multiple matching records are displayed, select a relevant contact.
2. If no single matching record is found, enter details based on the information given by the caller and click Search. Select a record if any.
3. If there is no record of the caller in the database, click Create Contact, and enter details.
4. Click Save and Close.

To save a search, click Save in the Search Results pane. You can run a saved search by selecting the search from the Saved Searches drop-down list.

Overview of Wrapping Up an Interaction

If your administrator has enabled the Wrap Up page, it will display at the end of your service calls or chat sessions. You use this page to capture closing interaction notes and any contextual information.

The ready to use Wrap Up page captures information such as the reason for call, the resolution code, and the interaction code. If there is other relevant information you want to capture, your administrator can configure it.

Captured contextual information such as contact name, phone, email helps you easily keep track of the information provided during a call or chat session. The Wrap Up page also displays the business objects that were updated during the interaction, which can include one or more service requests. Associated items are displayed as titles of the service request and are links. If Wrap Up is disabled for an interaction, and you’re working with an SR, you can review the transcript using the SR transcript message. Your administrator can use Application Composer to add field to the Wrap Up page.

If the Wrap Up page is timed out before you enter all of your details, navigate to the relevant service request, open the Interaction History, select the latest interaction, and complete the wrap-up details.

**Note:** When a call originates from a service request click to dial, or if the dialog box was to a service request, the wrap-up details are stored as service request messages within the relevant service request record. When the wrap-up is disabled for an interaction, and you’re working with an SR, you can review the transcript using the SR transcript message.
Wrap Up an Interaction

Wrap up an interaction in the Wrap Up page.

1. Select a **Communication Reason** from the drop-down list.
2. Select a **Resolution Code** to specify what’s the type of resolution that was provided.
3. Specify a **Transfer Reason** if you transfer the call is to another agent for resolution.
4. Enter **Interaction Notes** to detail the issue and resolution provided. You can also document any other details that must be mentioned as part of the service interaction record.
5. Click **End Wrap Up**.
7 Cobrowse

Enable and Use Cobrowse

Cobrowse enables you to view a customer's desktop to more efficiently resolve an issue. You use Cobrowse to have the same view as the customer, and review their issue. You must enable the cobrowse functionality in both the customer portal and Oracle B2B Service.

1. In the **Edit Service Request** page, click **Actions** and select **Launch co-browse**.
   Instruct the customer to launch the request live assistance functionality from the website that they are on currently. This request by the customer generates a security code, which they can share with you. By providing this code to you, the customer is verbally allowing you to view their screen.
2. Enter your first and last name and the code provided by the customer in the new console window that opens.
3. Click **Connect**.

Oracle Cobrowse

Oracle Cobrowse Cloud Service is a collaboration tool which helps agents collaborate with customers. Agents work on customer’s screen during real-time voice or chat interactions and guide them to resolutions.

Agents gain a better understanding of customer issues, resolve issues more quickly, and give the customer a greater level of understanding. Agents can also use Cobrowse as a sales conversion and customer support tool.

Oracle Cobrowse Cloud Service is available as both a standalone solution or as an integrated feature of Oracle B2B Service.

**Note:** To use Oracle Cobrowse, you must deploy the Cobrowse launcher script on your web site. For more information, refer to the Related Topics list.

**Related Topics**
- Using Standalone Co-Browse
- Implementing Standalone Co-Browse
- Configuring Standalone Co-Browse
- Administering Standalone Co-Browse
- Co-Browse In-App SDK for iOS and Android

Differences Between Cobrowsing and Screen Sharing

While the terms can often be used interchangeably, in a business setting there is an important difference between screen sharing technology and cobrowsing technology. Let's take a look these two use cases for the differences.

- Screen Sharing is basically a web collaboration session. One person allows one or more people to view his or her computer screen. In business, the screen is typically shared by the sales or customer service agent who
invites a customer to view an online demo, or a presentation. The sharer or host holds the license to use the screen sharing tool and is the one who's responsible for starting the sharing session.

- Cobrowsing is a screen sharing session which can be initiated by a customer or an agent. The sales or customer service agent can see the customer's screen and provide guidance and insights on what the customer is doing or seeing. In this case the sharer or host is the customer, but the license to use the Cobrowse tool is held by the company or agent. The customer doesn't have to sign up for anything, download anything, or do anything other than click a button to start the session.
8 Notifications

Omnichannel Notifications

How Omnichannel Notifications Work

Omnichannel routes notifications to you in the form of Omnichannel, Multi-Channel Architecture (MCA), and Live Window notifications, all with the same look and feel. The different types of notifications are described in the following list.

- Interactive notifications, such as chat offers, appear as pop-up windows which you can accept or decline. If you take no action, the notification times out. You can receive single work offers, or multiple work offers.
- Count down offers, which you accept or reject. If neither action is taken during a certain time frame, the offer is withdrawn or rerouted.
- Forced notifications open for viewing in a new tab. You can receive single notifications or a notification with several notifications rolled into it, each with a hyperlink which displays a brief description of the issue. Clicking any notification on the list leads to the appropriate view where you can view the item.
- A desktop or toast notification appears if you don't have B2B Service in focus on your desktop.

Bell Notifications for Service Requests

How You Manage Bell Notifications for SRs

Service request (SR) events trigger notifications to service agents and managers alerting them to take necessary action. Events are triggered for specific conditions, such as:

- SR is assigned
- SR is resolved
- SR is escalated
- Expired milestone

The Notifications icon on the global header displays the number of unread notifications. Click this icon to view all notifications. Click a notification to take further action. After you click a notification and navigate to the record's details, the notification is marked as read and it's cleared from the notification list.

An administrator enables notifications through the Notifications feature in the Setup and Maintenance work area. For more information about enabling notifications, see the "Enable Notifications for Service Requests" related topic. When notifications are enabled, bell notifications are automatically enabled for service requests. An administrator defines notification triggers as Groovy scripts in Application Composer, containing the conditions that must be met for each notification. Notifications are triggered when the defined conditions are met. For example, a trigger can be defined to send a notification when a high severity SR has been assigned to an agent. For more information about notification triggers, see the "Define Notification Triggers" related topic.
Personalize Your Notifications

How You Personalize Your Notifications

Have you ever wanted to control which notifications you receive, and through which delivery channels? Then the User Notification Preferences page’s got the solution for you!

Your administrator defines the notifications, the intended recipients, and the associated delivery channels. The User Notification Preferences page lets you select the notifications you want to receive, and also select their delivery channels. If your administrator hasn't defined you as a notification recipient, you can't opt in to a notification. You can only opt out of the notifications you don't want to receive.

Here's how you personalize your notifications:

1. In the Settings and Actions global header menu, click Set Preferences.
   
The Preferences page is displayed.
2. In the Service group, click User Notification Preferences.
   
The User Notification Preferences page is displayed.
3. Click Add.
4. From the Object drop-down list, select Service Request.
5. From the Notification Name drop-down list, select the notification you want to personalize.

   If your administrator disables a notification, or sets the OverrideFlag field to No (on the Notification Preferences page), you can't personalize that notification.
   
   o To stop receiving the selected notification, select No from the Enabled drop-down list.
   
   o To specify the delivery channels through which you receive the selected notification, select or deselect the channel check boxes accordingly.
6. Click Save and Close.

Unfollow Service Requests for Notifications

The Notifications Followed page lets you view all the SRs you're currently following to receive notifications. From that list, you can unfollow those SRs that you're no longer interested in receiving notifications.

You follow an SR by navigating to that service request’s details, and selecting Follow from the Actions menu. All SRs that you follow for notifications are listed on the Notifications Followed page. So, you need not navigate to each
individual service request’s details to unfollow the SRs for which you don’t want to receive notifications. Instead, you can quickly unfollow the SRs from this single list view.

Here’s how you do it:

1. In the **Settings and Actions** global header menu, click **Set Preferences**.
   
   The Preferences page is displayed.

2. In the **Service** group, click **User Notification Preferences**.
   
   The User Notification Preferences page is displayed.

3. Click the **Notifications Followed** tab.
   
   The Notifications Followed page is displayed.

4. Deselect the **Followed** check box for the SRs for which you don’t want to receive notifications.

5. Click **Done**.

---

**Push Notifications for Mobile**

**How You Manage SR Push Notifications on the Mobile Application**

As a service agent or manager, you can receive push notifications on your iOS and Android mobile devices if your administrator has enabled the **Mobile Notifications** feature in the **Setup and Maintenance** work area. For more information about enabling notifications, see the "Enable Notifications for Service Requests" related topic.

An event on the service request (SR) objects triggers push notifications on your mobile device. You can tap a notification to drill directly to the relevant service request. Events are specific trigger conditions relating to an SR, such as:

- SR is assigned
- SR is resolved
- SR is escalated
- Expired milestone

An administrator defines notification triggers as Groovy scripts in **Application Composer**. The scripts contain the conditions that must be met for each notification. Notifications are triggered when the defined conditions are met. For example, a trigger can be defined to send a notification when a high severity SR has been assigned to an agent. For more information about notification triggers, see the "Define Notification Triggers" related topic.

**Related Topics**

- Enable Notifications for Service Requests
- Define Notification Triggers
9 Work Orders

Generic Work Orders

Overview of Generic Work Orders

A work order can be any work performed at a customer site, like an installation, standard maintenance, or a repair request. A generic work order isn’t integrated to any other application.

Use generic work orders if you need to send field service technicians to resolve customer issues. Generic work orders are turned on and ready to use in B2B Service.

Work orders can have the following information:

- Customer contact information
- Type of work to be performed
- Date and time the work is scheduled
- Information about part orders

Create a Generic Work Order

You can open work orders through Service Requests, or from Work Orders from the Service springboard.

To create a work order, do the following:

1. Open Work Orders.
2. Click the Create Work Order button.
   If there is more than one type of work order, this is a drop-down list. Select the type of work order you want to create.
3. Complete the required fields.
4. Click Save and Close.

Related Topics

- Create and Edit a Service Request

Update a Generic Work Order

You can open work orders through Service Requests, or from Work Orders from the Service springboard.

To update a generic work order, do the following:

1. Open the work order.
2. Select the work order that you want to update.
3. Update with your changes.
4. Click **Save and Close**.

**Related Topics**
- Create and Edit a Service Request

## How to Estimate Charges and Order Parts on a Work Order: For Oracle Service Logistics Users

Sometimes parts are required for a work order. If you’re using Oracle Service Logistics, you can estimate labor, expense, and parts that are required by the field service technician. If the customer approves the estimated charges, you can order the parts and decide if the parts should be sent to the technician or the customer.

To estimate labor, expense, and parts, click the **Charges** button. The Manage Charges and Estimates window appears. For more information about adding charges and estimates see the related links at the end of this topic for the Create Charges and Estimate Charges topics.

To order parts, the Parts Details tab is available on the View Work Order page. When you save the work order, a transfer order is then created to ship the parts for the field service technician to use for the repair.

For more information about adding charges and estimates see the following Create Charges and Estimate Charges topic links.

**Related Topics**
- Order Technician Replaceable Parts
- Create Charges
- Estimate Charges

## Oracle Field Service Work Orders

### Overview of Work Orders

A work order can be any work performed at a customer site, like an installation, standard maintenance, or a repair request.

Creating an Oracle Field Service work order in B2B Service creates a corresponding activity in Oracle Field Service. When there are any updates made to the activity in Oracle Field Service, the work order is updated.

Work orders can have the following information:

- Customer contact information
- Information about the location where the work is to be performed
- Type of work to be performed
- Date and time to do the work
- SLA milestone resolution due (date and time work must be complete based on the service contract)
- Product and maintenance details necessary for completing the work
- The Oracle Field Service technician the work order is assigned to
Create a Work Order

You can open work orders through Service Requests, or from Work Orders from the Service springboard.

To create a work order, do the following:

1. Open Work Orders.
2. Click the **Create Work Order** button.
   
   If there is more than one type of work order, this is a drop-down list. Select the type of work order you want to create.
3. Select a contact from the list of values.
   
   **Note:** If two contacts are merged, you may see a change in the contact of a work order. The contact remaining after the merge is now associated with the work order, as it replaces the merged contact.
4. Enter information in the remaining fields using the following table as a guide:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>If the contact has a primary phone, it's automatically populated. If the contact has another phone, use <strong>Other Phone</strong> from the list of values. You can make changes to the contact's information by clicking the <strong>Manage Phone</strong> link in the list of values.</td>
</tr>
<tr>
<td>Email</td>
<td>If the contact has a primary email, it's automatically populated. You can change or add the contact's email by clicking the <strong>Manage Email</strong> link in the list of values.</td>
</tr>
<tr>
<td>Address</td>
<td>If the contact has a primary address, it's automatically populated. If the physical address where the work is being performed is different from the primary address, use the list of values to find the physical address. If the address doesn't exist in the list, add it by clicking the <strong>Manage Address</strong> link in the list of values.</td>
</tr>
</tbody>
</table>

5. Select the **Time Zone** for where the work is being performed.
6. Select the **Work Order Area** from the list of values.
   
   **Note:** If your company uses Direct Assignment scheduling, these fields will be reversed. You enter the Work Order Area First, and then the Time Zone.
7. Select the **Type of Work** to be performed from the list of values.
8. Optionally, enter a time (in minutes) for a **Reminder** to the customer.
   
   The reminder triggers the service representative to contact the customer to confirm the time that the technician is scheduled to perform the work.
9. **Schedule** the **Work Order** using either the **Scheduler** or **SLA Resolution Due**.

Using the Scheduler:

a. Click the **Calendar** icon in the **Requested** field. The calendar appears with information based on the work order type and work order area.
b. If your company uses Direct Assignment scheduling, the last two fields will be reversed. You enter the Work Order Area First, and then the Time Zone.

**Note:** If a resolution due is assigned from the SR, then you don’t have to select a time slot. If you select a time slot, it overrides the resolution due. If there’s no resolution due from the SR, then you have to select a time slot to save the work order.

c. Select a date and time slot on the calendar for when the work should be completed.
d. Click **Select**.

You’re taken back to the Create Work Order page.

The **Requested** field is now populated with the time and date (or the specific technician) you selected on the calendar.

10. Optionally, enter a **Case Note** for the technician.
11. Click **Save and Close**.

You see a confirmation message with the work order number. You can use that work order number for future searches.

12. Click **Refresh** on the Work Order page to validate that the work got scheduled.

The work order is created.

**Related Topics**
- Create and Edit a Service Request

### Update a Work Order

You can open work orders through Service Requests, or from Work Orders from the Service springboard.

To update a work order, do the following:

1. Open the work order.
2. Select the work order that you want to update.
3. Update the work order with your changes.
4. Click **Save**.

A confirmation message appears showing the change was submitted.

5. Click **Refresh** to see change confirmation. The work order is in read-only mode until the Oracle Field Service application acknowledges the change. This should only take a moment. When the change is confirmed, the Edit Work Order page appears with the change displayed.
6. Click **Save and Close**.

### Reschedule a Work Order

You can open work orders through Service Requests, or from Work Orders from the Service springboard.

To reschedule the date or time for a work order do the following:

1. Open the work order.
2. Click the work order number from the work order list.
3. Click the icon for the Calendar.
4. Depending on what type of scheduler your company uses, select a new date and time, or select a specific technician.
5. Click the link for the Requested Time and Date. You can also click the Calendar icon.
6. Select a new date and time on the calendar.
7. Enter a reason for rescheduling.
8. Click Select.
9. Click Save.

   Wait while the integration between B2B Service and Field Service confirms the rescheduling.

Oracle Integration Cloud now confirms the rescheduling.

10. Click Refresh to make sure the rescheduling is confirmed. The work order is in read-only mode until Oracle Field Service acknowledges the change. Once rescheduling is confirmed, the Edit Work Order page returns and the information for Requested and Scheduled match.

   **Note:** Rescheduling failures can be caused by the following:
   - Rescheduling was rejected by TOA.
   - Oracle Integration didn't connect to TOA. An administrator must manually reschedule the work order.

11. Click Save and Close.

Cancel a Work Order

You can open work orders through Service Requests, or from Work Orders from the Service springboard.

To cancel a work order:

1. Open the work order.
2. Click the work order number from the work order list.
3. Click Cancel Work Order.

   A warning message lets you know that you can't reopen canceled work orders.
4. Enter the Cancel Reason.
5. Click Cancel Work Order.

   The work order read-only until Oracle Field Service Cloud acknowledges the cancellation.

   You see a confirmation message.

How to Estimate Charges and Order Parts on a Work Order: For Oracle Service Logistics Users

Sometimes parts are required for a work order. If you're using Oracle Service Logistics, you can estimate labor, expense, and parts that are required by the field service technician. If the customer approves the estimated charges, you can order the parts and decide if the parts should be sent to the technician or the customer.
To estimate labor, expense, and parts, click the **Charges** button. The Manage Charges and Estimates window appears. For more information about adding charges and estimates see the related links at the end of this topic for the Create Charges and Estimate Charges topics.

To order parts, the Parts Details tab is available on the View Work Order page. When you save the work order, a transfer order is then created to ship the parts for the field service technician to use for the repair.

For more information about adding charges and estimates see the following Create Charges and Estimate Charges topic links.

**Related Topics**
- **Order Technician Replaceable Parts**
- **Create Charges**
- **Estimate Charges**

**FAQs about Work Orders**

**Why is someone else scheduled to complete the work when I requested a specific technician?**

If your company uses Direct Assignment scheduling, you can request specific technicians for the work order. If you've requested a specific technician and notice later that someone else was scheduled for the work, it could be, that technician is out for training, or out sick. You can request that technician again by clicking the calendar icon and searching for the next available time slot for that technician. Once you've done that, save the work order to see the update.

**How to View Audit History for a Work Order**

Use the **Audit History** tab on the Edit Work Order: Summary page to see work order audit reports. You can filter the audit reports by date, user, and events.

To view audit history for a work order do the following:

1. In the Edit Work Order: Summary page, click the **Audit** subtab.
2. Expand the **Search** region and select the date range for which you want the report.
3. Enter the other search details if required, such as **User Name** and, **Event Type**.
4. Click **Search**.
5. To export the report, click the **Export to Excel** icon, or click **Export to Excel** from the **Actions** menu.

You can save your search criteria by clicking **Save** in the **Search** region.
10 Service Analytics

View Service Analytics

Oracle Transactional Business Intelligence (OTBI) is a real-time, self-service reporting solution bundled with your service application. It provides prepackaged analytic content built on the Oracle Business Intelligence (BI) platform. Let's break down the different ways you can view prebuilt analytic content. The following tasks apply to all roles.

View Prebuilt Infolets and Detailed Reports

Use the Service Infolets page to perform the following task.

1. From the page control on the Home page, click the Service Infolets icon.
   The Service Infolets page is displayed. It displays the Infolets enabled for the signed in role.
2. Click any individual infotile to view a detailed report.

View Your Favorite Reports

Use the Analytics page to perform the following task.

1. From the springboard on the Home page, click Service, and then click Analytics.
   The Analytics page is displayed.
2. Click the Search icon to perform a keyword search on the reports in the BI Catalog.
3. In the search results, click the link for the report to view. You can view the reports in either a list or a carousel view.
   Optionally, you can mark reports as favorites for later access. This page also shows the analytics recently viewed by the signed in user.

View All Analytic Content

Use the BI Catalog and the Reports and Analytics page to view all analytic content.

To view all analytic content using the BI Catalog:

1. Click Navigator > Tools > Reports and Analytics.
   The Reports and Analytics page is displayed.
2. Click Browse Catalog.
   The BI Catalog is displayed.
3. View the list of the reports and dashboards in the Shared Folders > Service > Embedded Content and Shared Folders > Service > Subject Area Content folders.
   - Administrator-defined or user-defined content is displayed in the Shared Folders > Custom folder.
   - Personal content available only to you is displayed in the My Folders folder.
To view all analytic content using the Reports and Analytics page:

1. Click **Navigator > Tools > Reports and Analytics**.
   The Reports and Analytics page is displayed.
2. Click the **Hierarchical Selector >>** icon, and select **My Folders** or **Shared Folders** from the menu.
   The list of reports and dashboards is displayed, without navigation to BI Catalog. Similar to the Analytics page, you can perform a keyword search and mark your favorites, to retain them for easy access later.

**Related Topics**
- Oracle Business Intelligence Publisher
- Oracle Business Intelligence Enterprise Edition

### Create Service Analytics

Let's break down the different ways you can build your own content using subject areas.

### Create Quick Analyses

Casual users perform the following task on the Reports and Analytics page for simplified report authoring. This task applies to all roles.

1. Click **Navigator > Tools > Reports and Analytics**.
   The Reports and Analytics page is displayed.
2. Click the **Create** drop-down button and select **Analysis**.
   The **Select Subject Area** window is displayed.
3. Select a subject area and click **Continue** to create the analysis.

### Create Analyses

Report authors perform the following task in the BI Catalog. This task applies to the Administrator and Customer Service Manager roles.

1. Click **Navigator > Tools > Reports and Analytics**.
   The Reports and Analytics page is displayed.
2. Click **Browse Catalog**.
   The BI Catalog is displayed.
3. From the **New** menu, select **Analysis**.
   The **Select Subject Area** pane is displayed.
4. Click the link for the selected subject area and create the analysis.

### Create Production Reports

Advanced users perform the following task on the Reports and Analytics page and BI Catalog. This task applies to the Administrator and Customer Service Manager roles.
Note: Advanced users use the Oracle Business Intelligence Publisher (BI Publisher) application to create pixel perfect reports. The BI Publisher application isn't recommended for creating OTBI reports that can otherwise be created using Oracle Business Intelligence Enterprise Edition (OBIEE) Answers. For more information about the BI Publisher and OBIEE applications, see Related Topics. Additionally, you can also see the online help in the BI Catalog by clicking Help > Help Contents > Oracle BI Publisher and Help > Help Contents > Oracle BI EE.

To create production reports using the Reports and Analytics page:

1. Select Navigator > Tools > Reports and Analytics.
   The Reports and Analytics page is displayed.
2. Click the Create drop-down button and select Report.
   The Create Report window is displayed. Use this window to create the production report using any of the available options.

To create production reports using the BI Catalog:

1. Select Navigator > Tools > Reports and Analytics.
   The Reports and Analytics page is displayed.
2. Click Browse Catalog.
   The BI Catalog is displayed.
3. From the New menu, select Published Reporting > Report.
   The Create Report window is displayed. Use this window to create the production report using any of the available options.

Related Topics
• Oracle Business Intelligence Publisher
• Oracle Business Intelligence Enterprise Edition

Overview of Service Infolets

This section describes the Service infolets available to customer service representatives, customer service managers, help desk agents, and help desk managers.

<table>
<thead>
<tr>
<th>Infolet</th>
<th>Description</th>
<th>Job Role</th>
</tr>
</thead>
</table>
| My Resolve Time     | Shows the average time you took to resolve assigned service requests over a 30 day period. It enables you to view that information against the average time taken by all agents to resolve service requests over the same period of time. | • Customer Service Representative  
• Human Resource Help Desk Agent  
• Sales Administrator  
• Human Resource Help Desk Administrator |
| Pending Tasks       | Displays the pending tasks that are assigned to you along with the priority (high, medium, or low) of each. You can also view tasks that are past their due date.                                                  | • Customer Service Representative  
• Human Resource Help Desk Agent  
• Sales Administrator |

Oracle CX Service
Using B2B Service

Chapter 10
Service Analytics
<table>
<thead>
<tr>
<th>Infolet</th>
<th>Description</th>
<th>Job Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waiting on Customer</td>
<td>Displays an overview of the service requests that are waiting on the customer. You can view the following information:</td>
<td>• Customer Service Representative&lt;br&gt;• Human Resource Help Desk Agent&lt;br&gt;• Sales Administrator&lt;br&gt;• Human Resource Help Desk Administrator</td>
</tr>
<tr>
<td></td>
<td>• Number of service requests in the Waiting status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number of service requests that are resolved.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Total number of service requests assigned to the user, which includes both resolved requests and requests waiting on the customer.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Total number of critical service requests assigned to the user, which includes both resolved requests and requests waiting on the customer.</td>
<td></td>
</tr>
<tr>
<td>Waiting on Me</td>
<td>Displays an overview of the service requests that are waiting on the user. The infolets contain the following information about the service requests waiting on the user:</td>
<td>• Customer Service Representative&lt;br&gt;• Human Resource Help Desk Agent&lt;br&gt;• Sales Administrator&lt;br&gt;• Human Resource Help Desk Administrator</td>
</tr>
<tr>
<td></td>
<td>• Number of new service requests.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number of services requests that are in progress.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Total number of service requests that are awaiting a response from the user and are in progress.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Total number of unresolved service requests that are assigned to the user and are in critical status.</td>
<td></td>
</tr>
<tr>
<td>My SR Compliance</td>
<td>Displays an overview of all the milestones and their status on the service requests assigned to the user. This infolet contains the following information about the service requests milestones for the user:</td>
<td>• Customer Service Representative&lt;br&gt;• Sales Administrator</td>
</tr>
<tr>
<td></td>
<td>• Number of SRs assigned to the user that have milestones that are nearing their due date.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number of SRs that are assigned to the user where the milestone due dates have passed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Number of SRs that are nearing and already have noncompliance issues with milestones.</td>
<td></td>
</tr>
<tr>
<td>Infolet</td>
<td>Description</td>
<td>Job Role</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>My Open Work Orders</td>
<td>Shows a listing of open work orders assigned to the signed in user, which are expected to be noncompliant, where the estimated end date is past the resolution due date. A listing of work orders that are noncompliant (where the actual end date is past the resolution due date), and are expected to be compliant, can also be optionally viewed.</td>
<td>Customer Service Representative, Sales Administrator</td>
</tr>
<tr>
<td>My Completed Work Orders</td>
<td>Shows a listing of noncompliant work orders assigned to the signed in user, where the actual end date is past the resolution due date. You can also optionally view the compliant work orders.</td>
<td>Customer Service Representative, Sales Administrator</td>
</tr>
<tr>
<td>My Action Plan Actions Past Due</td>
<td>Shows the actions that have end dates in the past. The total count represents unique actions. The actions for the action plans associated with the SRs assigned to the signed in user, are considered.</td>
<td>Customer Service Representative, Sales Administrator</td>
</tr>
<tr>
<td>My SR Work Time</td>
<td>Shows the actual duration an SR was with the agent before it was resolved. This excludes customer wait time, the duration when it wasn't yet assigned, or assigned to other agents. The KPI for all agents of the team that the signed in agent belongs to, is also shown. Only the SRs resolved in the last 30 days are considered.</td>
<td>Customer Service Representative, Sales Administrator</td>
</tr>
<tr>
<td>SR Movement in Queues</td>
<td>Shows the average number of queues that an SR has traversed before it was resolved. The average days that an SR is in queue, not in queue, and average days to resolve are also shown. Team SRs resolved during the past 30 days are considered.</td>
<td>Customer Service Representative, Sales Administrator</td>
</tr>
<tr>
<td>Agents with Most Pending Service Requests</td>
<td>Displays the top-three agents that have the most pending service requests, and the number of service requests that are pending. Pending service requests are requests that are in a New or In progress state, and are pending action by the agent. These requests don't include the requests that are waiting on the customer.</td>
<td>Customer Service Manager, Human Resource Help Desk Manager, Sales Administrator, Human Resource Help Desk Administrator</td>
</tr>
<tr>
<td>Long Wait on Agent</td>
<td>Number of service requests that are waiting on the agent for longer than 24 hours.</td>
<td>Customer Service Manager, Human Resource Help Desk Manager, Sales Administrator</td>
</tr>
<tr>
<td>Infolet</td>
<td>Description</td>
<td>Job Role</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Queues by Unassigned Service Requests</td>
<td>Number of unassigned service requests in each queue. The graph also displays the priority of the service requests in the queues.</td>
<td>• Human Resource Help Desk Administrator</td>
</tr>
</tbody>
</table>
| Team Resolve Time                | The average resolution time of the service requests resolved in the last 30 days, by any user in the signed-in service manager’s team. The time is displayed in the number of days, hours, and minutes. | • Customer Service Manager  
• Human Resource Help Desk Manager  
• Sales Administrator  
• Human Resource Help Desk Administrator |
| Critical Service Requests        | The average resolution time of the service requests resolved in the last 30 days, by any user in the signed-in service manager’s team. | • Customer Service Manager  
• Human Resource Help Desk Manager  
• Sales Administrator  
• Human Resource Help Desk Administrator |
| Team SR Compliance               | Displays an overview of all the milestones and their status on the service requests assigned to the team. This infolet contains the following information about the service requests milestones in the team:  
• Number of SRs assigned to the team that have milestones that are nearing their due date.  
• Number of SRs that are assigned to the team where the milestone due dates have passed.  
• Number of SRs that are nearing and already have noncompliance issues with milestones and are assigned to the team members.  
• The number of SRs that have a critical status. | • Customer Service Manager  
• Sales Administrator |
| Inbound Emails                   | Shows the total number of inbound emails during the past 30 days. A breakdown of this total by the number that resulted in SR creations, SR updates, and number of emails that failed is also shown. | • Customer Service Manager  
• Human Resource Help Desk Manager  
• Sales Administrator  
• Human Resource Help Desk Administrator |
| Inbound Social Posts             | Shows the total number of social posts during the past 30 days. A breakdown of this total by the number that resulted in | • Customer Service Manager  
• Sales Administrator |
<table>
<thead>
<tr>
<th>Infolet</th>
<th>Description</th>
<th>Job Role</th>
</tr>
</thead>
</table>
| Omnichannel Agent Assignments       | Shows the top-five agents with the most work assignments during the past seven days. | • Customer Service Manager  
• Sales Administrator                                                            |
| Omnichannel Assignments             | Shows the top-five queue assignments by channel type for the past seven days.                     | • Customer Service Manager  
• Sales Administrator                                                            |
| Omnichannel Queue Assignments       | Shows the top-five queues with the most work assignments during the past seven days.                 | • Customer Service Manager  
• Sales Administrator                                                            |
| Team Open Work Orders               | Shows a listing of open work orders assigned to the signed in user and the user’s subordinates, which are expected to be noncompliant, where the estimated end date is past the resolution due date. A listing of work orders that are noncompliant (where the actual end date is past the resolution due date), and are expected to be compliant, can also be optionally viewed. | • Customer Service Manager  
• Sales Administrator                                                            |
| Team Completed Work Orders          | Shows a listing of noncompliant work orders assigned to the signed in user and the user’s subordinates, where the actual end date is past the resolution due date. Compliant work orders can also be optionally viewed. | • Customer Service Manager  
• Sales Administrator                                                            |
| Team Action Plan Actions Past Due   | Shows the actions that have end dates in the past. The total count represents unique actions. The actions for the action plans associated with the SRs assigned to the signed in user’s team, are considered. | • Customer Service Manager  
• Sales Administrator                                                            |
| Team SR Work Time                   | The average actual duration an SR was with the agent before it was resolved. This excludes customer wait time, the duration when it wasn’t yet assigned, or assigned to other agents. The metric for all agents is also shown. Team SRs resolved during the last 30 days are considered. | • Customer Service Manager  
• Human Resource Help Desk Manager  
• Sales Administrator  
• Human Resource Help Desk Administrator                                           |

For more information about Analytics, see Related Topics.

**Related Topics**

- Creating and Administering Analytics